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Introduction to STARCAM 

STARCAM system consists of three modules, including drawing module (StarCAD), nesting 

module (StarCUT) and numerical control code emulation module (StarTEST). each of which can 

not only run independently but also call each other, and support numerical control program of the 

controlling machine of multiple kinds of numerical control cutting equipment, in which, 

 Interacting parameter drawing: User can choose any operation type by choice boxes in 

convenience while coordinate figures adopt interactive input. Pop-up input of former 

edition is canceled as the interacting operation is strong and easier to handle. 

 Drawing module can do operations for cut parts, such as drawing making, editing, 

zooming, copying, arraying, revolving and so on. Also it supports import and export 

operation for CAD graph files with other formats, such as CAM, DXF, DWG and IGES, 

and does optimization processing for CAD graphs. Besides it can generate machining 

codes needed by both cutting path and numerical control machining. 

 Nesting module can do nesting of several or batch parts in rectangle or excess plate, not 

only improving the utilization ratio of plate but also with high speed and high efficiency. It 

supports manual nesting, matrix nesting, interactive nesting and excess plate nesting, 

and quickly generates numerical control codes needed by multiple kinds of numerical 

control cutting equipment. 

 Emulation module can do graph emulation in computer for NC codes generated by the 

above-mentioned two modules, and do single step run and step-by-step emulation, also 

edit and modify NC codes in the process of emulation, test and verify the correctness and 

rationality of NC codes, so as to improve production efficiency. 

New characters of STARCAM drawing, nesting system: 

 Automatic position catch function: be geared to traditional drawing software, has 

additionally control point catch function, including midpoint, endpoint, quadrantal point, 

crossing point, entity point, and so on, improving the operability of software, as well as 

the drawing speed and interactivity. 

 Window scale display function: the added window scale function can directly reflect size 

of the part and plate. The scale can dynamically change following the zoom of the part. 

So users can directly see the size and coordinate position of the part. 

 Add special display function when entity is selected: improve the identifiability for users. 

Also add the direction of the Offset Contour direction, convenient for user’s selection. 

 Add the apex angle transition processing after the cutter path compensation: prevent the 

part graph from having the problems of contour line disconnection and distortion, etc. 

after the cutter path compensation. 



 Support the import edit of other graph file formats: can do import/export and edit 

operations for files with the graph formats of AUTOCAD, FASTCAM and so on. 

 Smart Trim function: can quickly trim or cancel the graph’s line section or circular arc, 

with simple and practical ways. 

 Automatic path setup function: can quickly generate processing path as well as entry and 

Exit of the part, and dynamically modify the position of entry or Exit, so as to reduce the 

part interference and improve the utilization ratio of plate. 

 CAD clean and CAD compress function: the CAD clean function can be used to clear 

excess line sections and duplicate entities in CAD graph. The CAD compress function 

can compress numerous small line sections in graph file, so as to reduce the quantity of 

entity and improve cutting efficiency. 

 The nesting module has a functional increase of continuous short-line cut. When there is 

comparatively short distance between the leadin and leadout of each part, the leadout of the 

previous part will directly and continuously cut to the leadin of the next part. Thus it is 

unnecessary to do re-perforation, reducing thereby the number of perforation. 

 The nesting module has a functional increase of total edge-sharing blowdown. For a large number 

of parts with a straight-line profile, when nesting, blowdown is done directly according to the 

slotted width, and only one time of cut is done at the position of the shared edge, greatly reducing 

both the number of perforation and the cut length. 

 The nesting module has a functional increase of bridging by drawing a line. The bridge connector 

can connect profiles of multiple parts into one profile, reducing the number of perforation and 

effectively extending life span of the cutting torch. 

 The nesting module has a functional increase of generation of excess plate and its nesting. For the 

excess plate to be processed, an excess plate file can be automatically generated for users to insert 

excess plate for nesting in future cut. 

 The nesting module has a functional increase of file modification control tool, by which users can edit 

NC codes post-processing file according to the code format of the used control system, so as to ensure 

the generated NC code adaptable to their used control system. 



Software Installation Guide 

Note: Before installation, please insert the encryption lock, enclosed with the software, into 

USB interface, and then install according to following steps. If without inserting the encryption lock 

when installing, the program can not be used after installation. 

 I. StarCAM Installation  

1. Double click the file of Setup.exe in the root directory of optical disk, and enter Figure 1 to 

start installation. 

 

Figure 1 

2. Click the button “Next”, and enter the license interface as shown in Figure 2. 

 

Figure 2 

3. After select “I agree the clauses of the license”, click the button “Next”, and enter Figure 3. 



 

Figure 3 

4. Input the user name and the company name, and click the button “Next” to enter Figure 4. 

 

Figure 4 

5. If selecting custom installation, users can install STARCAM system selectively, and then 

click the button “Next” to enter Figure 5. 

 

Figure 5 

6. When clicking the button “Change…”, users can select installation path, and then click the 



button “Next” to enter Figure 6. 

 

Figure 6 

7. Select the file to be installed, and click the button “Next” to enter Figure 7. If selecting “All” 

in Figure 4, then directly enter Figure 7. 

 

Figure 7 

8. Click the button “Next”, and then enter Figure 8 to start copying the file.  

 



Figure 8 

9. If forgetting to insert the encryption lock when installing the software, insert the encryption 

lock when the prompt shown in Figure 9 appears, then click the button “Yes”, the file can 

be copied continuously. 

 

Figure 9 

10. When completing the file copying, the interface of installation having been finished 

appears, as shown in Figure 10. 

 

Figure 10 

Click the button “Complete” to finish installation. And then the installation program will 

automatically put onto the desktop three shortcut icons, which respectively represent the system’s 

drawing program (StarCAM), nesting program (StarCUT) and emulation program (StarTEST), as 

shown in Figure 11. 

 

Figure 11 

 



II. StarCAM UnIntall  

1. If the software has been installed, when double clicking the file Setup.exe, the download 

repair interface shown in Figure 12 can be entered. 

 

Figure 12 

2. If selecting the single choice box “Modify” or “Repair”, click “Next”, then same as part of 

installation interfaces, part of files will be added or cancelled or files will be repaired. If 

selecting “Remove” and then clicking the button “Next”, the interface shown in Figure 13 will 

be entered. 

 

Figure 13 

3. Click “No” to exit the operation, click “Yes” to enter the interface shown in Figure 14 to 

download files. 



 

Figure 14 

After downloading, the finish interface shown in Figure 15 will be entered. 

 

Figure 15 

Click the button “Complete” to finish the download operation. Also the download can be finished 

through the add/remove program in Windows control panel. 



 

 STARCAD Drawing 

As  a  CAD  drawing  software  with  independent  copyright,  StarCAD  can  satisfy  NC  cutter  user’s 

requirements on fast rendering of cutting parts. With the working mode of interactive operation, StarCAD 

can  structure,  edit  and modify  geometric  figures  fastly.  As  the  software  is  simple  in  operation mode, 

powerful in interactivity and easy to handle, it will help the designers to unleash creativity, raise working 

efficiency, cut product’s design cycle, free designers from heavy design drawing, contribute to  improving 

the standardization, serialization and generalization of product design and standardizing the whole design.   

I. Quick Starts 

1. Run StarCAD: 

After the software is right installed completely, an icon of “StarCAD Drawing Jacking” will appear in 

the desktop (shown in the following figure): 

Double click this icon will open the main screen window of StarCAM drawing jacking (as shown in 

the following figure): 

 

Click “StarCAD” button to enter StarCAD drawing.  



2. StarCAD drawing interface 

User interface is the information intermediary between interactive drawing software and user. Through the 

interface, system can reflect current information condition or the next operation while user can make a 

judgment based on information shown in the interface and carry out the next operation through input 

devices. 

User interface of StarCAD Drawing mainly includes seven parts: menu bar, toolbar, drawing area, ruler, 

prompt area of status bar, numerical value input area and quick menu (as shown in the following figure). 

 

Moreover, the interactive mode of quick menu in StarCAD Drawing makes operation transition more 

direct and convenient. 

3. Basic Operation 

1) Operation mode 

As StarCAD supports both menu operation and tool button operation, user can choose operation mode in 

the menu or click corresponding tool button to choose operation mode. For example, when user needs to 

draw a straight line, he can enter in either following way: 

 Choose the submenu “straight line” in “Drawing”. 

 Choose the straight line tool . 



Then click the choice box in straight line quick menu to choose how to draw the straight line (as shown in 

the following figure): 

  

If the chosen operation needs interactive input of relevant parameters, please input related parameters in 

“parameter interactive sector” (numerical values such as length, angle and radius and so on) (as shown in 

the following figure).  

 

Finally choose the reference points of figure drawing in drawing area to complete the operation. 

2) The input of coordinate points 

 Direct keyboard input: When prompt area requests input coordinate value, user can use keyboard 

to input coordinate values directly, which will be shown in the left of numerical value area (as 

shown in the following figure). 

 

 Or input in the parameter interactive box: click parameter input textbox to have numerical value 

input box. After input parameter values in the numerical value input box, click the button “√” to 

enter (as shown in the following figure). 

 

 Intelligent point catch input: User can use the mouse to directly catch the intelligent points of the 

entity to input coordinate points. The system supports the intelligent point as shown in the 

following figure: catch box will appear automatically when the mouse moves on the entity, and 

left click to input automatically.  

 

Screen points Any location points on the screen 

End point Endpoints of curve 



Centre Midpoint of straight line 

Centre of a circle Centre of a circle or an arc 

Crossing point Crossing point between 2 arcs 

Point of Tangency Point of contact on an arc 

Perpendicular Foot point of a straight line 

Closest point The point on a curve closest to catch cursor 

point Drawn point on screen  

Quadrant point Quadrant point of a circle or an arc 

3) Activate and pick entity 

When user needs to manipulate a drawing element in drawing area – entity, he has to pick the entity 

(activate it) or activate many entities (entity set) at the same time following the screen prompts (as shown 

in the following figure) to make the picked entity red. User can modify, move, copy and mirror the active 

entity. An entity or an entity set has to be picked before being edited or modified. Standard picking is 

shown as follow:  

 

Contour Pick the contour drawn by one or many entities. 

Inside the window 
Pick entities inside a rectangle, which is pulled in drawing 

area by user. 

Outside the window 
Pick entities outside a rectangle, which is pulled in drawing 

area by user. 

Single Pick a single entity with the mouse. 

All Pick any entity. 

Line Only entity of straight line can be picked. 

Arc Only entity of arc can be picked.  

Text Only entity of text can be picked.  

Point Only entity of point can be picked.  

To cancel the picking, right click or choose other operation.  

II. File operation  

StarCAD provides operations to build file, save file, lead in and lead out file, output drawing, part data and 



print, with which it is convenient and flexible to manage the original files or drawing information on the 

screen. Ordered file management environment, not only facilitating use but also raising working efficiency 

of drawing, is an indispensable part in drawing system. Main functions of file operation are as followed: 

 

1. New 

Function: Build a new figure file.  

Operation: Click the button of “New”  in main toolbar or choose [New] menu under [File] menu. 

If there is figure under process which is not saved yet on the screen, the system will prompt user to 

save the current edited file. When a new file is built, some parameters of the system will return the 

original state.  

2. Open 

Function: Open a saved figure file into the current view.  

Operation: Click the button of “Open”  in main toolbar or choose [Open] menu under [File] 

menu. If there is figure under process which is not saved yet on the screen, the system will prompt user 

to save the current edited file. When a file is open, some parameters of the system will return the 

original state. 

3. Save 

Function: Save figures in the current drawing area into a disk file.  

Operation: Click the button of “Save”  in main toolbar or choose [Save] menu under [File] 

menu. The system will pop up the following dialog box of part data to prompt user to input part data 

for this part.  



 

After finishing inputting the data, click “Enter”. And then the system will open the dialog box of saving file 

to prompt user to save the currently edited file (as shown in the following figure). The file will be saved 

after user finishes inputting file name and choosing save location.  

 

4. Save part 

Function: Save a part figure in the current drawing area as a disk file. 

Operation: Choose [Save part] menu under [File] menu; follow system prompts to choose the external 

contour of an independent part figure in the current view; right click to pop up the dialog box of file 

save (as shown in the figure above), which prompts user to save the part. 

Notice: With this function, user can pick up respectively every part in a same figure file and save them 

independently. It is especially useful when user opens a jacking figure file and pick up a file therein.  

5. Part data 

Function: Add part data to the current part to satisfy the requirements of production and management.  

Operation: Choose [Part data] menu under [File] menu to pop up a dialog box of part data to make 

user input relevant data.  

6. Lead in 

Function: Open the commonly used DXF, DWG  and IGES format file. 

Operation: Click "file imports" under "file" menu menu, when the import file, if you are editing 

graphics file has not been inventory, the system will pop up whether to save the prompt dialog box, 

according to the need to decide whether to save. 

Please select files in the file type select box , the system supports the following file types: 



 DXF: Open DXF figure file of AUTOCAD. Metric units will be used by default when files are 

read in, while the system will automatically clean needless data in the part at the same time.  

 DWG: Read in DWG figure files (.dwg). 

 IGES: Read in IGES figure files (.igs). 

Notice: As there is much layer information, label information and other information in CAD figures, 

the system will delete useless information automatically. If it fails to read in files, it is possible that the 

CAD files are of too high edition. In this case, user can save the file in AUTOCAD as lower edition of 

DXF or DWG files. Currently the system supports AUTOCAD2004 and earlier editions.  

Note: 1. because there are many layers in the CAD graphic information, mark information and other information, 

the system will automatically delete useless information.If the file import, failure may be caused by CAD file 

format version is too high, but in the heart of the AUTOCAD DXF file is saved as a low version format file or 

DWG file, the system support AUTOCAD2004 and previous versions. 

     2. if import or DWG DXF file is English unit graphics drawn parts, please check the lower right corner in 

the open file dialog box "Ince" checkbox. 

7. Lead out 

Function: With submenu therein, save the current figure as files of DXF and etc.  

Operation: Click [Lead out] under [File] menu and choose DXF file to pop up a dialog box of file 

save to save files.  

8. Print screen 

Function: Send the current screen figure to chosen printer. When user choose this function, the system 

will pop up a dialog of print preview where user can choose printer.  

Operation: Click [Print screen] under [File] menu or click the icon  in main toolbar to pop up a 

dialog box of file print preview as shown in the following figure: 

 



After setting relevant information and install printer correctly, user can print the screen by clicking “Print”. 

9. File browser 

Function: Open Windows resource manager. The system provides shortcut of Windows resource 

manager, with which user can manage and check file catalogue fast.  

Operation: Click [File] -> [File browser] menu. 

10. Exit 

Function: Exit STARCAM module. If there is any figure that has not been saved yet, the system will 

prompt user whether to save the CAM file before exit the system.  

Operation: Click [Exit] menu under [File] menu or click the button  at the top right corner of the 

main window to exit STARCAD drawing program.  

11. Recently files 

Function: List 5 figure files recently opened in STARCAD. User can choose files to edit fast based on 

needs. 

Operation: Click [Recently used files] menu under [File] menu and choose needed files to open them. 

 

III. Edit 

Graphic editing function includes selecting the entity, undoing the operation, repeating the operation, 

copying the graph, cutting the graph, pasting the graph, inserting a graph, deleting parts, deleting the whole 

graph and other basic editing functions. Besides, there are functions specially set for cutting industry like 

deleting repeated objects, deleting plate data and CAD amendment. The main functions of the editing 

operation are as shown. 

 



1. UnDO 

Function: Undo the last operation on the current graph. 

Operation: Click the [UnDO] menu under the [Edit] menu, or click the  icon on the main 

toolbar. 

2. ReDO 

Function: Restore the last undo operation on the current graph. 

Operation: Click the [ReDO] menu under the [Edit] menu, or click the  icon on the main 

toolbar. 

3. Select the Object 

Function: Select an entity from the current graph in the way selected by the user. 

Operation: Click the [Select the Object] menu under the [Edit] menu. When the following quick 

menu shows up, the user can choose the entity selection modes and selection types: 

 

The Object] selection types are as follows: 

 Single: In this selection type, the user can select an individual entity object to delete. 

 Contour: In this selection type, the user can directly select an entity contour, and the system 

regards the contour and the internal entities as the selected objects to be deleted. 

 In-the-window: In this selection type, the user will be prompted to drag a window with the mouse, 

and entities all included within the window are regarded as the selected objects to be deleted. 

Entities outside the window and part of the entities that are included within the window are not 

regarded as the selected objects to be deleted. 

 Outside-the-window: In this selection type, the user will be prompted to drag a window with the 

mouse, entities all included within the window are not regarded as the selected objects to be 

deleted. Entities outside the window and part of the entities that are included within the window 

are regarded as the selected objects to be deleted. 

The selection types of the entities to be deleted are as follows: 

 All: any types of entity objects can be chosen. 

 Lines: only line entities can be chosen. 



 Arcs: only arc entities and circle entities can be chosen. 

 Text: only text entities can be chosen. 

 Points: only point entities can be chosen. 

4. Copy 

Function: Copy the selected entities to the system clipboard for a paste operation after which the 

original entities are retained. 

Operation: Click the [Copy] menu under the [Edit] menu, or click the  icon on the main toolbar. 

When the system prompts to select entities, the user may select the entity set according to the "Entity 

selection", right-click to end the selection, and follow the prompts to give the entity positioning 

reference point. Then, the entity set is copied to the system clipboard. 

5. Cut 

Function: Cut the selected entities to the system clipboard for a paste operation after which the 

original entities are not retained. 

Operation: Click the [Cut] menu under the [Edit] menu, or click the  icon on the main toolbar. 

When the system prompts to select entities, the user may select the entity set according to the "Entity 

selection", right-click to end the selection, and follow the prompts to give the entity positioning 

reference point. Then, the entity set is cut to the system clipboard. 

Note: When the prompt of “data in the pasteboard” shows up, press "ESC" to clear the clipboard data. 

6. Paste 

Function: Paste the entity set in the system clipboard to the location of the reference point given by 

the user. Continuous pastes are available. 

Operation: Click the [Paste] menu under the [Edit] menu, or click the  icon on the main toolbar. 

When the system prompts to give the location of the reference point where the entity set will be pasted, 

the user can enter the coordinates values or capture the screen point to give the reference point with the 

mouse. Then, the entity set is pasted to the reference point, and continuous pastes are available till 

right-clicking the mouse to end the operation. 

Note: This operation must be after a "copy" or "cut" operation. 

7. Insert a graph 

Function: Graphic files stored on disk can be inserted into the current drawing area. 

Operation: Click the [Insert a graph] menu under the [Edit] menu, and the system will pop up the File 

Open dialog box (below). The user selects the file, clicks "Open", and follows the prompts to give the 

insert coordinates of the reference point or screen point of the graph. 



8. Delete entities 

Function: Quickly delete a single entity or multiple entity objects. 

Operation: See the "delete" operation. 

9. Delete parts 

Function: Quickly delete the graphics of the individual parts in the current drawing area. 

Operation: Click the [Delete parts] menu under the [Edit] menu. Click the mouse to delete the 

contours of the parts, and the parts will be displayed in red. Right-click the mouse to end the selection, 

the system will pop up the deleting prompt dialog box, and click "OK" to complete the parts deleting 

operation. 

10. Delete All 

Function: Quickly delete all entity objects in the current drawing area. 

Operation: Click the [Delete the whole graph] menu under the [Edit] menu, and the system will pop 

up the deleting prompt dialog box. Click "OK" to complete the total graph deletion operation. 

11. Delete repeated objects 

Function: Automatically identify and delete the repeated objects in the current drawing area (entities 

with exactly the same parameters), if there are any. 

Operation: Click the [Delete repeated objects] menu under the [Edit] menu, and the system will 

automatically identify if there are repeated objects. If there are repeated objects, the prompt box of 

deleting repeated objects will pop up automatically to prompt the user to confirm (see below) the 

deletion. If there are no repeated objects, the system will naturally end the operation. 

 

12. Delete plate data 

Function: Mainly used to delete the plate border lines of the nesting graphics output by StarCUT.  

Operation: Click the [Delete plate data] menu under the [Edit] menu, and the system will 

automatically check if there are plate data in the current graph. If plate data exists, the entities will be 

shown with red plate border line to prompt the user to confirm the deletion (see below). If there are no 

plate data, the prompt of “no plate data found in the current graph” will show up in the status bar. 



 

13. CAD Amendment 

Function: Mainly used to delete the repeated segments in the opening DXF or DWG file, and to 

compress small arcs, short straight lines to the specified accuracy in order to reduce the number of 

entities, shorten the length of the NC code and improve the nesting and cutting speed. 

Operation: When importing DXF or DWG files of the AUTOCAD, click the [CAD Amendment] 

menu under the [Edit] menu, follow the following system prompts to select and fill out the following 

quick menu item (below), and press Enter to modify. 

 

 Clear objects: Whether to automatically delete repeated objects. 

 Clear isolated objects: Whether to automatically delete not-closed single entity (independent 

segments). 

 Gap: Whether to consider the gap which is less than the given value as invalid and automatically 

close the gap. 

 Compress: Whether to compress the current graph. 

 lehgth: Whether to fit several arcs and straight lines which are less than the segment value with 

big arcs and long straight lines. 

 Compression arc: Whether to compress a small arc. 

 precision:: Compression error shall not be greater than the subsequent settings. 

app:ds:precision�


Operation Example: Import the following DWG Graph: The graph has a large quantity of small arcs 

and lines with diameters less than the cutting torch. 

 

Select the "All entities parameters" under the "tool" menu, showing that there are 1158 entities in the 

graph. 

 

Select the "CAD Amendment" menu, and fill out the parameters in the following quick menu item: 

 

Press Enter to perform CAD amendment. Select the "All entities parameters" again under the "tool" 

menu, showing that there are only 578 entities in the graph. If the error is increased to 1mm, the 

number of entities will be only about 300. 



 

14. Change layer 

Function: modify the current graphics entities in the layer properties, to set the processing type of the 

entity. 

Operation: under the current state of the plot has a graphic, click on the menu "edit" ->” Change layer” 

menu, choose the option in the quick menu drop-down box, select to modify the attributes of entities, click 

the right mouse button, and on the shortcut menu (below) to select the entity will set the layer name, click 

the "select" complete set. 

 

 

IV. View operation 



 

1. Refresh   

Function: Refresh the drawing area to clean redundant traces left on the screen in entity drawing and 

editing.  

Operation: Choose [Refresh] menu under [View] menu.  

2. Window view 

Function: Full-screen display the chosen part of window in active window to satisfy user’s 

requirements to zoom in part of figure.  

Operation: Click the button of “Zoom-in”  in main toolbar or choose [Window view] menu 

under [View] menu. After user pulls mouse to choose the part to be zoomed in, the system will 

automatically full-screen display the window content. 

3. Center view 

Function: Display the current drawing window with the given location or screen catch point as display 

center. 

Operation: Click the button of “Center display”  in main toolbar or choose [Center view] menu 

under [View] menu. 

 Input coordinate of center: Choose this mode to pop up the following dialog box, where user has 

to give coordinates of display center. System automatically gives coordinates of the current 

center.  

 



 Given center: In this mode, user should click the location to be display center in the screen. 

4. Zoom in 

Function: Zoom in content in the current screen for 0.8 times.  

Operation: Click the button of “Zoom in”  in main toolbar or choose [Zoom in] menu under 

[View] menu. 

5. Zoom out 

Function: Zoom out content in the current screen for 0.8 times. 

Operation: Click the button of “Zoom out”  in main toolbar or choose [Zoom out] menu under 

[View] menu. 

6. Full screen  

Function: Full-screen display the current figure (full display). 

Operation: Click the button of “Full-screen”  in main toolbar or choose [Full-screen display] 

menu under [View] menu. 

7. Previous View  

Function: Return to the former display mode (display backtrace). 

Operation: Click the button of “Former display”  in main toolbar or choose [Previous View ] 

menu under [View] menu. 

8. Scaled display 

Function: Display the window in given scaling.  

Operation: Click the button of “Scaled display”  in main toolbar or choose [Scaled display] 

menu under [View] menu. 

Notice: User can also directly zoom in and out the window by rolling the mouse wheel.  

9. Move screen 

Function: Move the current drawing window.  

Operation: Click the button of “Scaled display”  in main toolbar to drag the window by mouse. 

Notice: User can also press the middle button of mouse to directly drag the window.  

10. Display control point 

Function: Display all control points of entities in the current drawing window.  Control point is the 



key coordinate point in entity drawing.  

Operation: Click the button of “Control point”  in main toolbar or choose [Display control point] 

menu under [View] menu. 

Notice: It is a switch in this function, which will be open by clicking for the first time and closed by 

the second time.  

11. Display set 

Function: Set display mode in the current view. User can choose in the four switch choices.  

Operation: Choose [Display set] menu under [View] menu to pop up the following dialog box: 

 

 Automatic dimensioning: When the option is chosen, the system will label sizes of all entities in 

the view. This function is closed by default.  

 Axis: When the option is chosen, the system will display X/Y axis. This function is closed by 

default. 

 Direction: When the option is chosen, inserted processing path will automatically label the 

direction of processing path. This function is closed by default. 

 DXF layer: When the option is chosen, different processing layers will be displayed in different 

colors. This function is open by default.. 

 

V. Draw menu 

As the basic elements to form a parts figure, basic entities combine to realize all figures. It is the basic skill 

of a draftsman to learn how to draw basic entities.  

Entity drawing menu in StarCAD Drawing includes: (as shown in the following figure) 



 

1. line 

Straight line is a basic element to draw figures. StarCAD Drawing provides many drawing ways including 

end points, parallel line, angle line, angular bisector and tangent, in which user can choose through the 

quick menu in function of straight line. Detailed introduction is as followed. 

Operation: Click the button “Straight line”  in the “Paint tools”, or choose [line] under [Draw] menu.  

1) End points 

Function: Draw a straight segment in 2 given points or draw continuous straight segment in given 

points of continuity.  

Operation: Under function of straight line, click the quick menu at the bottom of the screen and 

choose “end points” in the pop-up box of the quick menu (as shown in the following figure). Then 

choose “single” or “continuity” in type box.  

    

 Continuity: Draw continuous straight line with point coordinates given by user, in which the first 

point is the start point while the second point is the end point of the first straight line. After the 

first straight line, the second straight line can be drawn only with its end point. More continuous 



straight lines can be drawn in this method until user right clicks to stop the operation.  

 Single: With two coordinates given by user, draw a straight line between the two points. This 

operation can repeat until user right clicks to stop the operation. 

2) Angle line 

Function: Draw straight lines at an angle to X and Y axis or to another straight line. Straight line is 

infinite construction line.  

Operation: Under function of straight line, click the quick menu at the bottom of the screen and 

choose “angle line” in the pop-up box of the quick menu (as shown in the following figure). Then 

choose “to X axis”, “to Y axis” or “to line” in type box. 

   

 To X axis: After user inputs the angle to X axis in the angle input box and give a coordinate of 

this straight line on the screen, the system will draw a construction line crossing this point and at 

the given angle to X axis.  

 To Y axis: After user inputs the angle to Y axis in the angle input box and give a coordinate of 

this straight line on the screen, the system will draw a construction line crossing this point and at 

the given angle to Y axis. 

 To line: After user inputs the angle to the straight line in the angle input box, choose reference 

straight line on the screen and give a coordinate of this straight line on the screen, the system will 

draw a construction line crossing this point and at the given angle to the reference straight line. 

3) Angular bisector 

Function: Draw an angular bisector of a crossing angle in two given straight lines. Direction of the 

straight line is decided by user through location of the line.  

Operation: Under function of straight line, click the quick menu at the bottom of the screen and 

choose “angular bisector” in the pop-up box of the quick menu (as shown in the following figure). 

After choose straight line of “given length” (input length in logarithm input box) or infinite 

“construction line” in the second type box, choose the two straight lines forming crossing angle by 

successive clicking.  

    



 Construction line: Infinite straight line, generally taken as composition reference line and deleted 

after drawing.  

 Given length: Length of the angle bisector can be given in length parameter input box.  

 Notice: As two crossing straight lines can produce four angles, different positions of clicks will 

lead to different positions of angle bisector, as shown in the following figures.  

     

4) Angle tangent 

Function: Draw a straight line contact a single circle and at an angle to another straight line.  

Operation: Under function of straight line, click the quick menu at the bottom of the screen and 

choose “angle tangent” in the pop-up box of the quick menu (as shown in the following figure). After 

choose “to X axis”, “to Y axis” or “to line” in type box, input angle in parameter input box.  

    

 To X axis: After user follows prompts to choose the circle or arc tangent to the straight line, the 

system will automatically produce a straight line contact the circle and at a given angle to X axis.  

 To Y axis: After user follows prompts to choose the circle or arc tangent to the straight line, the 

system will automatically produce a straight line contact the circle and at a given angle to Y axis. 

 To line: After user follows prompts to choose the circle or arc tangent to the straight line and 

another straight line to form a angle, the system will produce a straight line tangent to the circle 

and at a given angle to the straight line. The following figure shows a straight tangent to the 

circle and at right angle to straight line 1. 



 

5) Tangent of given point 

Function: Draw a straight line tangent to a single circle or an arc and crossing a given point.  

Operation: Under function of straight line, click the quick menu at the bottom of the screen and 

choose “tangent with given point” in the pop-up box of the quick menu (as shown in the following 

figure). 

 

After user follows prompts to choose the circle or arc tangent to the straight line and the point which the 

straight line will cross, the system will produce a straight line tangent to the circle and crossing the given 

point. The following figure shows a straight line tangent to a circle and crossing the end point of straight 

line 1. 

 

6) Tangent of two circles 

Function: Draw a straight line tangent to two circles or arcs.  

Operation: Under function of straight line, click the quick menu at the bottom of the screen and 

choose “tangent of two circles” in the pop-up box of the quick menu (as shown in the following 

figure). 



 

After user successively clicks the two circles or arcs tangent to the straight line, the system will produce 

automatically a straight line tangent to the two circles or arcs.  

Notice: Different positions of clicks will lead to different location of the tangent. The following figure 

shows different tangents produced from different clicks on points 1 and 3, 2 and 4, 1 and 4, 2 and 3. 

 

7) Vertical line 

Function: Draw a straight line vertical to another entity.  

Operation: Under function of straight line, click the quick menu at the bottom of the screen and 

choose “vertical line” in the pop-up box of the quick menu (as shown in the following figure). 

 

After user follows prompts to choose the entity vertical to the straight line and give a point vertical to the 

entity, the system will produce automatically a straight line vertical to the entity and crossing the given 

point. The following figure shows a straight line crossing point 1 and vertical to the circle and a straight 

line crossing point 2 and vertical to the straight line.  

 



2. Parallel line 

Function: As the most common drawing mode in early composition, parallel line can fast build 

construction lines and points of figures. StarCAD provides modes of equilong parallel line, lengthened 

parallel line and parallel construction line.  

Operation: Click the button “Parallel line”  in the “Paint tools”, or choose [Parallel line] under 

[Drawing] menu. Input the parallel distance away from reference straight line in “distance” input box 

and choose length of parallel line in “length” choice box. User has choices as follow: 

 

 Same with the original entity: Draw a parallel line of the same length with reference entity.  

 Infinite construction line: Draw an infinite construction line parallel to the reference entity.  

 Ends-lengthened line: Draw a straight line parallel to target entity with ends lengthened to a given 

length (give the length in the following numerical value input box). 

The following figures show a parallel line of the same length with target straight line 1, a parallel 

construction line and ends-lengthened parallel line.  

   

3. Circle 

StarCAD Drawing provides center-radius circle and donut.  

Operation: Click the button “Circle”  in the “Paint tools”, or choose [Circle] under [Drawing] menu. 

Choose to draw a circle, donut or point- to-circle in the quick menu.  

 

1)  Circle 

Function: Draw a circle with given radius and center.  

Operation: Under function of circle, click the quick menu at the bottom of the screen, choose “circle” 

in the quick menu, give radius in “radius” input box and follow prompts to give location of center. 



2)  Ring 

Function: Draw a donut with given internal and external radius.  

Operation: Under function of circle, click the quick menu at the bottom of the screen, choose “Ring” 

in the quick menu, give internal and external diameter respectively in “internal radius” and “external 

radius” input box and follow prompts to give location of center. 

The following figure shows a circle with the left end of straight line 1 as its center and a donut with the 

right end of straight line 1 as its center.  

 

3) Point-to-circle 

Function: Based on drawn entity point, the system will produce automatically a circle of give radius. 

This function applies to cut holes at the point.  

Operation: Under function of circle, click the quick menu at the bottom of the screen, choose 

“point-to-circle” in the quick menu, give radius of the circle in radius input box and follows prompts 

on the screen to choose successively the entity points becoming circles.  

The following right figure shows circles automatically came from entity points in the following left figure.  

   

4. Arc 

Arc is also a basic element in figure drawing. StarCAD Drawing provides many ways to draw arc. Detailed 

introductions are as followed: 

Operation: Click the button “Arc”  in the “Paint tools”, or choose [Arc] under [Drawing] menu. 

Choose the way to draw arc in the quick menu at bottom of the screen. 



 

1) Start,Point,End 

Function: Draw an arc with given starting point, point on it and end point.  

Operation: Under function of arc, click the quick menu at the bottom of the screen, choose 

“Start,Point,End ” in the quick menu and follows prompts to give locations of starting point, point on 

the arc and end point. Location of points can be input directly or caught on the screen.  

The following figure shows a three-point arc with the left bottom end of triangle as its starting point, the up 

end of triangle as the point on the arc and the right bottom end of triangle as its end point.  

 

2) Start, centre ,End  

Function: Draw an arc with given starting point, center and end point. 

Operation: Under function of arc, click the quick menu at the bottom of the screen, choose “Start, 

centre ,End ” in the quick menu and follows prompts to give locations of starting point, center and end 

point. Location of points can be input directly or caught on the screen. 

The following figure shows an arc with the left bottom end of triangle as its starting point, the up end of 

triangle as its center and the right bottom end of triangle as its end point. 

 

3) Start, End ,radius 

Function: Draw an arc with given starting point, end point and radius. 



Operation: Under function of arc, click the quick menu at the bottom of the screen, choose “Start, 

End ,radius ” in the quick menu, input radius in radius input box and follows prompts to give 

locations of starting point and end point. Location of points can be input directly or caught on the 

screen. 

4) Centre, Rradius ,A1,A2 

Function: Draw an arc with given center, radius, starting angle and ending angle.  

Operation: Under function of arc, click the quick menu at the bottom of the screen, choose “Centre, 

Rradius ,A1,A2” in the quick menu, input radius in radius input box, starting angle and ending angle 

respectively in starting angle and ending angle input box and follow prompts to give locations of 

central point. 

The following figure shows an arc with radius of 200mm, starting angle of 0 degree, ending angle of 

120 degree and central point as point A. 

 

Notice: The arc will be anticlockwise with positive angle, otherwise clockwise with positive angle. 

5) Centre, Rradius ,A1, radian  

Function: Draw an arc with given center, radius, starting angle and radian. 

Operation: Under function of arc, click the quick menu at the bottom of the screen, choose “Centre, 

Rradius ,A1, radian ” in the quick menu, input radius in radius input box, starting angle in starting 

angle input box, radian in radian input box and follow prompts to give locations of center. 

The following figure shows an arc with radius of 200mm, starting angle of 90 degree, radian of 120 degree 

and center as point A. 

 

6) Tangent 3 line  

Function: Draw an arc tangent to 3 given straight lines. 



Operation: Under function of arc, click the quick menu at the bottom of the screen, choose “Tangent 

3 line ” in the quick menu and follow prompts to respectively choose the  straight lines 3 tangent to 

the arc. Radius of the arc will be calculated automatically by the system.  

The following figure shows an arc tangent to straight line 1, 2 and 3. 

 

5. Ellipse 

Draw ellipse with given long and short axis and rotation angle.  

Operation: Click the button “Ellipse”  in the “Paint tools”, or choose [Ellipse] under [Drawing] 

menu. After input given short axis diameter in the short axis diameter input box and input the two 

coordinates on the long axis or directly catch existing coordinates on the screen, user will get the 

required ellipse.  

 

Notice: Rotation angle of the ellipse will be decided by the angle between the axis formed by two ends of 

the long axis and X axis.  

The following figure shows an ellipse with long axis diameter of 300mm, short axis of 200mm and rotation 

angle of 45 degree (with the angle of 45 degree drawn at advance). 

 

6. Point 

Function: Entity point can be used as location reference point, line transect location point and drilling 

location point of drilling layer.  

Operation: Click the button “Point”  in the “Paint tools”, or choose [Point] under [Drawing] 

menu. Choose the way to draw the point in the quick menu at the bottom of the screen. 



 

1) point: Draw a point at given coordinate or by catching a location on the screen.  

2) Contour point: After user chooses “contour point” in quick menu, input separation distance and 

amount of points respectively in parameter input boxes, follows prompts to choose entity to be 

bisected and choose drawing direction, the system will automatically draw equidistant points on 

the given entity based on the given separation distance and amount. In case of no given amount, 

the system will automatically calculate the amount based on entity length.  

The following figure shows equidistant points with separation distance of 100 and amount of 5 on entities 

of arc and rectangle.  

 

3) Circle to point (window): After user chooses “Circle to point (window)” in quick menu, follows 

prompts to choose a sample entity circle to be transformed into point and pulls a rectangle 

window with mouse on the screen, the system will automatically transform all the circles with the 

same diameter with the sample in the window into points.  

4) Circle to point (all): After user chooses “Circle to point (all)” in quick menu and follows prompts 

to choose a sample entity circle to be transformed into point, the system will automatically 

transformed all the circles with the same diameter with the sample in the current figure into 

points. 

The following right figure shows points transformed from circles in the left figure. 

  

7. Rectangle 



Draw rectangles with given coordinates of the two across angles, with given length and width and square 

with given length.  

Operation: Click the button “Rectangle”  in the “Paint tools”, or choose [Rectangle] under [Drawing] 

menu. Choose the way to draw rectangle in the quick menu at the bottom of the screen. 

 

1) Opposite angles 

Function: Draw rectangle with given coordinates of any two across points.  

Operation: Under function of rectangle, click the quick menu at the bottom of the screen, default 

choose “Opposite angles” in the quick menu and follow prompts to directly input coordinates of two 

across points or directly catch existing point on the screen, and the system will automatically produce 

a rectangle with across points.  

2) Length and width 

Function: Draw rectangles with given length, width and rotation angle.  

Operation: Under function of rectangle, click the quick menu at the bottom of the screen, default 

choose “length and width” in the quick menu, input length and width respectively in length and width 

parameter input boxes, input rotation angle in angle parameter input box and follow prompts to give 

the central coordinate of the rectangle or directly catch existing central coordinate on the screen, and 

then the system will automatically produce a required rectangle with given length, width and rotation 

angle. 

 

The following figure shows example of a rectangle with the length of 400mm, width of 300mm and 

rotation angle of 45 degree.  

 

3) Square 



Function: Draw square with given length and rotation angle.  

Operation: Under function of rectangle, click the quick menu at the bottom of the screen, default 

choose “square” in the quick menu, input length and rotation angle respectively in length and angle 

parameter input boxes and follow prompts to give the central coordinate of the square or directly catch 

existing central coordinate on the screen, and then the system will automatically produce a required 

square with given length and rotation angle. 

4) Line to groove 

Function: Transform drawn segment into groove of given width.  

Operation: Under function of rectangle, click the quick menu at the bottom of the screen, default 

choose “line to groove” in the quick menu, input groove width in width parameter input box and 

follow prompts to successively choose entities to be transformed into grooves, and then the system 

will automatically transform the entities into grooves of given width. 

The following right figure shows grooves transformed from segments in left figure.  

  

8. Polygon 

Function: Draw polygon entity with given edge quantity, length and rotation angle.  

Operation: Click the button “Polygon”   in the “Paint tools”, or choose [Polygon] under 

[Drawing] menu. After user input edge quantity, length and rotation angle (angle between bottom and 

X axis) respectively in parameter input boxes, as shown in the following figure, follows prompts to 

give the center coordinate or directly catch existing center coordinate on the screen, the system will 

automatically produce the required polygon with given length, edge quantity and rotation angle.  

 

The following figure shows a heptagon with edge length of 200mm and rotation angle of 15 degree.  



 

9. Faired Line  

Function: Draw line transects with given fitting precision and coordinates.  

Operation: Click the button “Line transect”  in the “Paint tools”, or choose [Faired  Line[] 

under [Drawing] menu. Choose whether to “close” and input fitting precision parameter value in 

parameter input box, and then follow prompts to successively input coordinates of fitting points or 

choose drawn fitting points entities on the screen. After user right clicks to finish the above mentioned 

input, the system will automatically produce line transect entity crossing the fitting point.  

 

The following figures show line transects respectively crossing entity point 1, 2, 3 and 4, among which 

“close” is chosen in the right figure.  

  

10. Arc Connection 

Function: Draw arc transition line between two entities with given radius (arc and arc, straight line and 

arc, straight line and straight line). Depth of the arc transition line will be automatically decided by the 

location of user’s clicks.  

Operation: Click the button “Arc transition”  in the “ToolBar”, or choose [Arc connection] 

under [Drawing] menu, give the radius of transition arc in parameter input box and follow prompts to 

successively choose the two entities contours which will be arc transited. 

 

Notice: Based on different locations and order of user’s choices on entities contours, depth of transition 



arc will be automatically decided. Too small arc radius (less than half of the distance between two entities) 

will produce no transition arc.  

The following figure 1 shows transition arc produced by clicks on points 1 and 2, 3 and 4 inside the circles; 

the following figure 2 shows transition arc produced by respective clicks on points 1and 4, 3 and 2, 4 and 1, 

2 and 3; the following figure 3 shows transition arc produced by clicks on points 1 and 2, 3 and 4 outside 

the two circles. 

   

11． Contour line 

Function: can quickly paint is composed of linear and circular arc closed or not closed contour line, 

equivalent to a popular line of polysemy in the drawing software. 

Operation: click on the "drawing tools" "profile" button in the toolbar  ，Or select "" drawing" 

menu under "profile" menu. And choose to draw in the mode selection box "line" or "circular", will be 

given according to the user coordinate values or screen capture point for drawing. 

 

Straight line: into drawing a straight line in a row, including: 

 Freedom: draw a straight line between any two points; 

 Orthogonal: straight line drawing and a drawing or circular arc orthogonal (vertical) straight line, 

 Tangent: straight line drawing and a drawing or circular arc tangent line, 

Arc: continuous arc rendering into the mapping between any two points. 

12. Text markup 

Function: can be fast to single line word notes, it is mainly used for layer of powder spraying marking 

processing.Support in both Chinese and English text annotations. 

Operation: click on the "drawing tools" "single body text" button in the toolbar  ，Or select " drawing" 

menu under the “single line text” menu.  in the pop-up dialog box input text content, and select the font, font 

size, aspect ratio, vertical and horizontal line, position of reference point, metric system and proportion, click on 

the "output" button, and then in the plot the insertion point position is given.  



 

13. Library  operation 

In order to facilitate management of user’s parts library, the system supports user’s gallery management. 

User can insert figure parts from gallery to the current drawing area, insert figures on the current screen to 

gallery and manage gallery (deleting, adding and renaming, etc). 

1) Pick up parts 

Function: Insert a single entity in the drawing area or entities in enclosed contour as a part to part 

figure. 

Operation: Choose the submenu [Pick up part] under [Contour operation] menu under [Drawing] 

menu. The system will prompt user to choose a completed part in the current drawing area. After user 

clicks the external contour of the part, the external contour and the internal entities all become red, 

which means active. At the same time, the system will pop up the following figure:  



 

When user chooses an object library file in the drop-down list of “Choose figure category”, the button 

“Insert figure to gallery” will be bright. Click the button of “Insert figure to gallery” to pop up the prompt 

box as follow: 

 

Here user can input a name for the part and click “Enter” to insert the part figure to the given object library. 

If the part is not needed, please activate the part and click “Delete”. 

2) Insert parts 

Function: Insert a part from gallery to given location in the current drawing area.  

Operation: Click the button “Galley operation”  in the “Paint tools”, or choose submenu [Insert 

part] under [Gallery operation] menu under [Drawing] menu to pop up the dialog box of gallery 

management (as shown in the following figure): 



 

After user chooses a source library in the drop-down menu of “Choose figure category”, the box of 

“Choose figure” will display all parts in this source library. Click the part name to be inserted, and preview 

of all parts will be displayed in “Figure preview” box in the right. Sizes can also be displayed when “Size 

display” is chosen. In the bottom of the preview box, enlarging scale and rotation angle of inserted parts 

can also be inserted. After user clicks the button of “Enter” and follows prompts to give parts and input 

point coordinate, the part will be automatically inserted to required location. 

3) Library management 

Function: Gallery maintenance and management 

Operation: Click the button “Library operation”  in the “Paint tools”, or choose submenu [Insert 

part] under [Library operation] menu under [Drawing] menu to pop up the dialog box of gallery 

management (as shown in the following figure). 



 

User can maintain and manage the gallery. 

 Delete parts in the gallery: Choose a source library in the drop-down menu of “Choose figure 

category”; choose a part by its name in the box of “Choose parts”; click button of “Delete” to pop 

up dialog box “Are you sure to delete?”; click “Yes” to delete the part from object gallery.  

 Rename user’s parts: Choose a part; click the button of “Rename” to pop up the part name input 

box; input a new name; click “Enter” to modify the name of the chosen part.  

 New PartLib: Click the button of “New gallery” to create a new gallery; input the name and 

click “Enter”. Gallery will be saved in LIB subdirectory under the installation directory, where 

user can delete gallery manually.  

 

 

VI. Modify 

As a function to edit and modify the current figure, figure edition and modification is an indispensable 

basic function of interactive drawing software. If draftsman is skilled in this function, drawing speed and 

quality will be improved. With the full consideration of user’s need, StarCAD provides a featured and 

convenient edition and modification function.  



The entity edition and modification menu of StarCAD includes the following functions (as shown in the 

following figure): 

 

1. Delete 

Function: Delete single or several entities fast.  

Operation: Click the button “Delete”  in the “Modification tools”, or choose [Delete] menu 

under [Modification] menu. Under deleting function, user can choose the way to delete object and entity 

type to be deleted through quick menu (as shown in the following figure 1) with the active entity displayed 

in red segment. Right click to finish choosing and choose “Enter” in the prompt box shown in the following 

figure 2 to complete deleting.  

 

Ways to activate entities are as followed: 

 

1. Single: User can choose single entity object to delete.  

2. Contour: User can directly choose contour of an entity while the system will take both this contour 



and internal entities as chosen objects to be deleted.  

3. Inside the window: User can follow prompts to pull a window by mouse and entities wholly included 

in the window will be taken as chosen objects to be deleted. Entities outside the window and partly 

included in the window will not be deleted.  

4. Outside the window: User can follow prompts to pull a window by mouse and entities wholly included 

in the window will not be taken as chosen objects or be deleted. Entities outside the window and 

partly included in the window will be deleted. 

Ways to choose deleted entities types are as followed: 

 

 All: Any type of entity object can be chosen.  

 Line: Only straight line entity can be chosen.  

 Arc: Only arc and circle entity can be chosen.  

 Text: Only text entity can be chosen. 

 Point: Only point entity can be chosen.  

Notes: In case of mistake deleting, “Undo” will undelete entities.  

2. Quick trim 

Function: Trim and delete redundant segments of single entity or crossing entities fast. The system can 

automatically calculate the crossing point and trim redundant segments at crossing point in the given 

location. It is the most common used edition tool in edition and modification.  

Operation: Click the button of “Intelligent trim”  in “Modification tools” or choose [Quick trim 

trim] menu under [Modification] menu.  

The following right figure shows the result after redundant segments in left figure are trimmed.  

  



3. Move 

Function: Move the chosen entity to the given location. 

Operation: Click the button of “Move”  in “Modification tools” or choose [Move] menu under 

[Modification] menu. Follow system prompts to successively choose entity set to be moved; right click to 

finish choosing; follow system prompts to choose the location reference point of moved object; give object 

location coordinate of moved entity or catch screen point by mouse. Then the system will automatically 

move the chosen entity to object location based on reference point and delete the entity at original location.  

As shown in the following figure, the circle at top left corner of the rectangle moves to object point, bottom 

right corner of the rectangle, with the corner as reference point.  

  

Ways to choose entities and types in this operation are the same with “Delete” operation.  

4. Copy 

Function: Copy the chosen entity to given locations. 

Operation: Click the button of “Copy”  in “Modification tools” or choose [Copy] menu under 

[Modification] menu. Follow system prompts to successively choose entity set to be copied; right click to 

finish choosing; follow system prompts to choose the location reference point of copied object; give object 

location coordinate of copied entity or catch screen point by mouse. Then the system will automatically 

copy the chosen entity to object location based on reference point and remain the entity at original location. 

As shown in the following figure, the circle at top left corner of the rectangle is copied to object points, the 

other three corners of the rectangle, with the corner as reference point.  

  

Ways to choose entities and types in this operation are the same with “Delete” operation.  



5. Mirror 

Function: With a straight line as symmetry axis, mirror or symmetrically copy the chosen entity.  

Operation: Click the button of “Mirror”  in “Modification tools” or choose [Mirror] menu under 

[Modification] menu. Follow system prompts to successively choose entity set to be mirrored; right click to 

finish choosing; follow system prompts to choose mirroring line. Then the system will automatically 

calculate the location and distance of the entity to mirroring line and produce a mirrored entity set at the 

other side of mirroring line. User can choose whether to remain the original entity set.  

 

As shown in the following figures, part to the left of the straight line is mirrored to the right with the 

straight line as mirroring axis and the entity set to the left is remained.  

  

Ways to choose entities and types in this operation are the same with that of  “Delete” operation.  

6. Scale 

Function: Scale chosen entities at given scale factor and reference point.  

Operation: Click the button of “Scale”  in “Modification tools” or choose [Scale] menu under 

[Modification] menu. Follow system prompts to successively choose entity set to be zoomed; right 

click to finish choosing; follow system prompts to give reference point and scale factor of zoomed 

entity (zoom in with factor larger than 1 and zoom out with factor smaller than 1). Then the system 

will zoom the entity set at reference point. User can choose whether to remain the original entity set. 

 

In the following figure, the left entity is zoomed out to a half, becoming the right entity.  



 

Ways to choose entities and types in this operation are the same with “Delete” operation.  

7. Rotate 

Function: Rotate the chosen entity at given angle and reference point.  

Operation: Click the button of “Rotate”  in “Modification tools” or choose [Rotate] menu under 

[Modification] menu. Follow system prompts to successively choose entity set to be rotated; right 

click to finish choosing; follow system prompts to give reference point and rotation angle of rotated 

entity (angle anticlockwise to X axis is taken positive). Then the system will rotate the entity set at 

reference point. User can choose whether to remain the original entity set. 

 

The following figure shows the result of rotating the left figure at 90 degree.  

  

Ways to choose entities and types in this operation are the same with “Delete” operation.  

8. Array 

Function: Circle or rectangular array the chosen entities in chosen array type and given array 

parameter. This operation will produce several part figures with similar entity contour fast.  

Operation: Click the button of “Array”  in “Modification tools” or choose [Array] menu under 

[Modification] menu. Follow system prompts to successively choose entity set to be arrayed; right click to 

finish choosing; follow system prompts to choose array type (circle or rectangular array); give array 



parameters relevant to array type and location of array reference point.  

 

 

In the following left figure, lifting hook in figure above is circle arrayed for 8 with point A as reference 

point while in the following left figure, it is rectangular arrayed for 3 lines and 3 rows with point A as 

reference point.  

  

Ways to choose entities and types in this operation are the same with “Delete” operation.  

9. Angle transition 

Function: Transition process angle formed by straight lines with right angle, round corner, corner cut, 

internal and external round corner, internal and external sharp corner.  

Operation: Click the button of “Angle transition”  in “Modification tools” or choose [Angle 

transition] menu under [Modification] menu. Choose transition type and give transition parameter in quick 

menu and follow system prompts to successively choose the two straight lines forming the angle. 

Transition types are as follow:  

 

The following figure shows several angle transitions on angles of a rectangle.  



 

10. Break 

Function: Break given entity. 

Operation: Click the button of “Break”  in “Modification tools” or choose [Break] menu under 

[Modification] menu. Follow system prompts to choose entities to be broken and give location of 

breaking.  

11. Aligning Side 

Function: Lengthen or shorten the given entity to reference position. 

Operation: Click the button of “Aligning Side”  in “Modification tools” or choose [Aligning Side] 

menu under [Modification] menu. Follow system prompts to choose scissors line; choose successively 

entities to be trimmed as scissors line. And then the chosen entities will automatically be lengthened or 

shortened to location of scissors line. 

The following right figure shows the result that the three entities in the left figure are aligned with scissors 

line. 

  

12. Convex-concave cut 

Function: Transform the given straight line with semicircle or rectangle, up or down.  

Operation: Click the button of “Convex-concave cut”  in “Modification tools” or choose 

[Convex-concave cut] menu under [Modification] menu. Choose cut type (the following figure) and 

cut parameters (the following figure 2) in quick menu box; follow system prompts to choose the 

straight line to be transformed; then give coordinates of the cut center on the straight line or catch the 

point on the screen.  



 

In the following right figure, the four straight lines in the left figure are convex-concave transformed in 

weight of 150mm and depth of 100mm. 

  

In the following right figure, the four straight lines in the left figure are semicircle transformed in radius of 

150mm. 

  

13. Outline Scale 

Function: Magnify or shrink the given contour. 

Operation: Click the button of “Outline Scale”  in “Modification tools” or choose [Outline Scale] 

menu under [Modification] menu. Choose whether the original entity is remained and zoom distance in 

quick menu box; follow system prompts to choose the contour to be zoomed; follow direction prompts to 

choose zoom direction.  

 

In the following right figures, entity in the following left figure is magnified at width of 50mm (with the 

original entity remained). 

  



14. Bridge 

Function: Bridge two part contours at given width. This function mainly applies to unify several part 

contours in part cutting, to lower cost of cutting torch by reducing quantity of holes. 

Operation: Click the button of “Bridge”  in “Modification tools” or choose [Bridge] menu under 

[Modification] menu. Choose bridge type and give width in quick menu box; choose the bridge location 

along entity lines (entity bridge) or pull a straight line to realize bridge between several entities (line 

bridge).  

 Entity bridge: In this mode, user can click neighboring entity lines to realize bridge.  

 Line bridge: In this mode, user can pull a straight line, which passes several entities by mouse to 

realize bridge between several entities.  

In the following right figure, the three entities in the following left figure are entity bridged in width of 

5mm.  

  

 

VII.  Label 

The system provides simple text annotation and dimension functions as well as modification function to 

meet the needs of special parts. The main functions of the notes operations are as shown. 

 

1. Label text 

Function: Add text information in the current drawing area, such as the process descriptions of the 

parts, and so on. 



Operation: Click the  button on the "drawing tools" toolbar, or select the [note text] menu under 

the [notes] menu. Input text, text height, text rotation angle values and other parameters in turn in the data 

input area. Insert text and the coordinates by following the prompts, or the system will automatically draw 

the text in the specified location by capturing the text insertion point with the mouse. 

 

2. Modify text 

Function: Edit and modify the text information in the current drawing area. 

Operation: Select the [Modify text] menu under the [notes] menu. Follow the prompts to capture the 

added text and benchmark reference point (usually in the lower left corner of the text), and the system will 

pop up the text modification quick menu (below) to prompt the user to input new content and text  

 

parameters. Click "√" to finish the modification, and "X" to cancel the modification. 

3. Dimension 

Function: Note the geometric dimension of the entities. 

Operation: Click the  "notes" button on the "drawing tools" toolbar, or select the [note dimension] 

menu under the [notes] menu. Follow the on-screen prompts to select the control point locations of the 

entities to be marked, and instruct the note place of the entities. Then the system will complete the 

annotation of the entities. 

4. Delete last dimension 

Function: Delete the last dimension note 

Operation: Select the [delete the last note] menu under the [notes] menu. Use the "undo" to 

accomplish the same operation. 

5. Delete all dimension 

Function: Delete all the dimension notes on the current graph. 

Operation: Select the [delete all notes] menu under the [notes] menu. Use the "undo" to accomplish 

the same operation. 

VIII. Output  

StaCAD provides a simple parts processing function to meet the needs of non-nesting processing of 

individual part, plate positioning hole-opening processing, cutting gap processing and cutting large 

graphics. The main functions of the processing operation are as show. 



 

1. Trepanning mode 

Function: The menu item is for the selection of hook options. When selecting this item, the system 

defaults that the current processing is to open a hole with specified shape on the plate by the user. The user 

can pre-draw the shape of the hole to be cut at the specified location. The generated NC code under the 

plate hole-opening mode adopts the compensation method of using closed contour for internal 

compensation and the non-closed contour for no compensations in order to meet the needs of the user to 

open the hole in the plate. The following graph is the plate hole-opening diagram (black shows the plate, 

white shows the hole): 

 

Operation: Draw the noncircular holes graphics to be processed in the specified location of the 

drawing area, check the [processing] -> [Plate hole-opening mode] menu, select the [automatic path 

generation] menu, and the plate hole-opening cutting code will be generated. 

2. AutoPath settings 

Function: The system provides the automatic processing path setting function, and the user can set the 

processing parameters and path parameters of their own to meet the processing needs. 

Operation: Select the [Path parameters settings] menu under the [processing] menu,The system 

automatically pops up the automatic path parameter settings dialog box (see below), where five pages 

are for the user to select the settings, and some of the parameters are needed for the StarCUT nesting 

modules. 



 

1) Processing type selection page (see above) 

The processing methods are provided in the “Optional processing methods” in the left, such as MARKER 

(dusting / tag), CUT (Flame / ion cut), drilling (CNC drilling), and so on. After selecting the needed 

processing method, click ">>" arrow buttons and the method can be selected to the ‘selected processing 

methods’ in the right. 

Optional processing methods 

Here listed all the cutting processions defined by the StarCAM. The processing methods here are 

to be selected, and those not being selected are also stay here. Select the processing methods in 

this table, click the ">>" arrow buttons, and then the selected processing methods will be added to 

the Selected processing methods table. Select the "Selected processing methods", click the " << 

"arrow button to delete the currently selected cutting process, and put them back into the optional 

table. 

Selected processing methods 

After selecting the cutting methods in the "Optional processing methods", the user can press the 

arrow button in the right to add them to the "Selected processing methods" in the right. If several 

processing methods are needed, the user needs to set different layers to the entities to correspond. 

For example, if a part needs flame cutting and noted line, the corresponding layers of the part 

needs to be set first. And the MARKER (dusting / tag) and CUT (flame cutting) should be 

selected here. When this processing method is not needed, select this processing method and click 

the "<<" arrow buttons, and the processing method is put back into the optional table. 

Torch compensation direction 

Click here to change the direction of the torch compensation. Left compensation, no compensation 



and right compensation can be selected. 

Processing contour range 

Click here to select the inner contour, the outer contour or all the contours of the processing parts. 

For a common cutting, all the contours should be selected here, i.e. the inner and the outer contour 

should all be processed. 

Procession for 

All parts—This option will process all the parts in order in accordance with the cutting process. 

For example, note all the parts of the plate and then cut the whole plate, which is the most typical 

processing way of the cutting machine. In this way, the air-way move distance can be the 

minimum to make the time of converting the processing methods to be the shortest when noting 

and cutting the parts. 

One part after another—This option will note and cut a part. After a part is processed, the 

subsequent parts will be processed in order. 

Pre-perforate 

This function is that first perforating the whole plate before cutting. The user can pre-perforate 

using the scrap cutting head, and cut officially with a good cutting head after the perforation. 

2) The introduction / Lead settings (below) 

 

 The introduction line: Generally, perforations are needed in the cutting process. However the 

hole is usually larger than the cutting gap. If perforating on the contours of the work piece directly, 

the contour of the work piece will be destroyed, which is not expected in the processing. As a 

result, the perforation must be on the scrap, deviating from the contour of the work piece, and 

connected to the contour processing path through a line, which is called the introduction line. 



 The Lead: After the cutting is completed, in order to make the work piece to be cut completely 

and closed to ensure the integrity and smoothness of the work piece, a line is cut out of the work 

piece contour, which is called the lead. 

 Position: Position refers to the location of the introduction and lead lines on the parts. If the 

"corner perforation" is selected, the introduction line will be added to the nearest corner point of 

the set "location". If the "corner perforation" is not selected, the introduction line will be added to 

the midpoint of the nearest entities in the set "location". Depending on the type of introduction 

line, the starting point will be as close as possible to the required position. The optional positions 

are: upper left, lower left, upper right, lower right, top, right, bottom and left. 

 Corner perforation: If the corner perforation selection box is selected, the outer boundary 

introduction line will enter from the corner point of the entity. If not selected, the introduction line 

will enter from the midpoint of the entity which is nearest to the starting position of the selected 

position box. 

 Type: Types of the introduction lines can be straight line, quarter arc, semicircle, or null. 

 Angle: When the straight line type is selected, the angle function here is activated to set the angle 

of the introduced straight line which can be 0 degree, 45 degrees and 90 degrees. The angle of the 

introduced straight line is calculated on the basis of the cutting direction. If not reasonable, the 

introduction direction given by the arc or the straight lines can also be adjusted according to actual 

situations. 

 The internal and outer boundaries are the same: All the settings of the internal path and the 

outer boundary path are the same. All settings except the "position" are not optional. 

 Drill in the corner point: After the setting, all the introduction lines will start from the corner 

point which is nearest to the introduction line of the inner boundary. If the set corner does not 

exist, then the nearest point is automatically determined. 

 Break in the longest entities: When this option is selected, the longest entity should be found in 

the inner boundary, and break from the middle of this entity adding the introduction and lead 

lines. 

 Center perforation: When the radius of the small hole is greater than or equal to the length 

of the introduction and lead lines, the introduction and lead lines will perforate through the 

middle of the holes in order to ensure that the holes are properly cut. For example, if the length of 

the introduction line is set to be 10mm, while the radius of the small hole is 4mm, the introduction 

line will automatically perforate through the middle of the holes and the length of the introduction 

and lead lines will change to 4mm. 

3) Contour compensation/ Gap settings (below) 



 

 Contour NC compensation of the parts: When this function is selected and the compensation 

value is input, you can see the added parts are automatically added by the graphics of the contour 

compensation value. There will be no codes like G41 or G42 in the output codes, applying to the 

programming of those control machines which do not support automatic compensation codes. 

Note: The codes of the StarCUT common edge nesting will be automatically output in the 

compensation way, and the compensation amount is half of the slotted width. 

 Pad sewn cutting settings: In certain circumstances, when cutting a relatively long rectangle 

completely for one time, this will lead to a very serious deformation or even a trapezoid. As a 

result, this function will reduce the occurrence of this situation. The detailed performance is to 

leave one or more places uncut in one section of the cutting path. In this way, parts can be fixed 

where they are not cut to make the cutting work piece to be correct in size and to reduce 

deformation. 

 Gap settings: This function is similar to the pad sewn cutting, and the difference is that this 

function can add the introduction line, and the gap position is not determined by the number given 

by the contour. 

4) Nesting options (below) 



 

 Nesting settings 

Nesting starting position: Set up the arrangement starting position of the parts on the plate. For a 

multi-plates nesting, this setting is also applicable. The location of the starting point can be the 

upper left corner, lower left corner, upper right corner and lower right corner. The default setting 

is the upper left corner. 

Cutting sequence：means the cutting order of the parts on the plate, which can be divided into 

rows, columns and nearest. 

 Avoid holes：In some cutting process, the cut-off parts may tilt or fall. When the torch is on the 

move, the torch will automatically drop or collide to the steel plate if there are no plates in the 

bore or the plate tilts. With this function enabled, the torch will not go through the cut-off parts 

during the move 

 Continuous short air-way cutting: Cutting short air-way line function is used for the continuous 

cutting when the introduction line and the lead between the parts are hard to get close. There is no 

need for re-perforation, and the parts cutting speed can be greatly improved. 

After the setting, the short air-way length can be input into the input box. Please input the required 

value. After selecting this function, the original fast-moving line will become the directly cutting 

line to achieve continuous cutting, if the distance between the introduction lines of a part and the 

next part is less than the given air-way length and not going through the boundary of other parts. 

This option will greatly accelerate the cutting speed and reduce perforation. 

 contour line gap 

If there are unclosed curves, and the gap is less than or equal to the set "contour line gap". Then 



the system will automatically regard the unclosed curves as closed curves. 

3. Run Autopath  

Function: The automatic processing path of the current parts will be generated according to the 

automatic processing path parameters set by the users with fast speed and high efficiency. 

Operation: When there are entity graphics in the drawing area, select the [processing] menu -> 

[automatic path generation] menu, and the processing path of the parts will be generated according to 

the automatic processing path parameters. Check the "layer" and "direction" item in the [View] -> 

[Display Settings] menu, and the processing direction and path of the processing layer will be 

displayed. 

4. Indicate path 

Function: Manually set the processing path of the contour, and the user decides whether to add 

compensation and the compensation direction. 

Operation: When there are entity graphics in the drawing area, select the [processing] menu -> 

[manually specify the path] menu. The user is prompted to select the processing type (see below). 

 

After selecting the processing type and clicking the “select”, the user is prompted to select the 

compensation direction (see below). 

 

After selecting the compensation direction, the user is prompted to select the entity segment to be 



processed. After clicking the entity segment, the user is prompted to give the processing direction (see 

below). 

 

After selecting the processing direction, the user is prompted whether to add an introduction and lead 

lines or not (see below)?  

 

The user selects "Yes" to add the introduction and lead lines, "No" not to add the introduction and lead 

lines. After the selection, the user is prompted to select the type of the introduction and lead lines (see 

below). 

 

According to the type of the selected introduction and lead lines, the user is prompted to give the 

length and radius of the introduction and lead lines (see below). 

   

If the user chooses the introduction and lead lines to be straight line, the length and angle of the 

straight line should also be given (see below). 



 

After the user give the corresponding value, the system automatically generates a contour processing 

path. Select "Output NC” and the contour processing code can be generated. 

5. Delete all paths 

Function: Delete all processing path settings of the current graph. 

Operation: When there are path definitions, choose the [process] menu-> [delete all paths] menu. The 

system will delete all paths of the current graph. 

Note: When an error of the processing path occurs, this function can be selected to re-select the 

[automatic path generation] 

 

6. Path Sort 

Function: manually cutting path set sequence. 

Operation: Defined in path selection menu under the condition of "Output" - > " Path Sort " 

menu.Then click the path for processing parts in turn internal and external contours, system will add 

Numbers to select the path line.Order processing will be carried out according to the number. 

Note: when the choice should be within the contour, and outer contour. 

7. Clear Path Sort 

Function: delete the current graphics all the machining path on the order. 

Operation: in case a path defined selection menu “processing”- >” clear Path Sort” menu.All the paths on 

the system to the current graphics processing order number removed. 

8. Redefine Entry Line 

Function: Modify the introduction and lead lines position of the set path. 

Operation: When there are path definitions, choose [processing path] -> [modify the lead position] or 

click the  button on the main toolbar. Click the mouse to choose the position of the introduction 

and lead lines to join, and the system will automatically modify the current position of the introduction 

and lead lines. 

Note: The system can still support graph edition after joining the path, and automatically update the 

processing path after edition. The changed introduction and lead lines will not be reserved, so the user 



should change the position of the introduction and lead lines before outputting the NC code. 

9. Simulation  

Function: Directly go through the simulation process without generating NC code to verify whether 

the processing path is correct or not. 

Operation: Select [processing] -> [Simulation calibration] 

  [Simulation calibration] To do simulation processing, and the simulation process can be 

manually manipulated through the following keys: 

【ESC】 Or the tool of ending the operation will end the simulation processing. 

【Home】Start from the beginning. 

【End】   To the final step 

【PgUp】  To the previous step 

【PgDn】  To the next step 

【B】     Turn on / off the tracing simulation 

  [Simulation settings] To open the simulation parameters settings dialog box, as is shown below. 

 

Direction: determine whether the simulation graph will display the directional arrows of the 

processing path or not. 

Air-way: determine whether the simulation graph will display the Air-way code （G0 code）in the 

processing path or not. 

Perforation: determine whether the simulation graph will display the perforation code simulation in 

the processing path or not. 

Automatic step-by-step simulation interval: determine the consecutive time interval between the 

simulation processing step  



10. Output NC code 

Function: NC code required by the CNC machine is generated for parts whose cutting path has been 

set. The NC code can do simulation processing and modification in the PLOT simulation module. The 

generated NC code files can be sent to the CNC machine by U disk. 

Note: When the parts to be processed are not joined in a cutting path, the function is not available. 

Operation: When there are path definitions, choose [processing] -> [output NC code] or click the 

 button on the main toolbar to open the file save window requiring the user to input the name of 

the NC file to save. After inputting relevant information and click the save button, the user will be 

prompt to input the NC program number, which will automatically added to the prefix of the NC 

code(depending on the code format of the controller, and the program number will not be added to the 

prefix if the controller do not support program prefix). 

 

Click "OK", and the system requires the users to give the position of "quickly move to the starting 

point" (Figure 1) and the coordinates of "quickly move to return to the point" (Figure 2). 

 

 

 

After the user has selected, the system gives prompts of code simulation (see below). If the user 

chooses "Yes", then the TEST module is called for simulation operation. See the simulation 

instructions for details. 



 

11. Path angle transition 

Function: Do path angle transition process to angles added in the processing path in order to protect 

the angles of the parts from being mistakenly cut in the bevel cutting.  

Operation: Select the [processing] -> [path angle transition], and select the path angle transition 

parameters in the popped-up quick menu, as is shown below. 

 

 Round angle transition: Add the outer round angle transition path to the path. 

 Sharp angle transition: Add the outer sharp angle transition path to the path. 

 Round angle radius: Choose the round angle radius value of the round angle transition. 

 Sharp angle distance: Choose the sharp angle side length value of the sharp angle transition. 

 All: Do transition procession to angles in the inner contour and outer contour. 

 Outside: Do transition procession only to angles in the outer contour. 

 Inside: Do transition procession only to angles in the inner contour. 

The lower right graph is the instance showing the path round angle transition of the lower left graph. 

 

The lower right graph is the instance showing the path sharp angle transition of the lower left graph.  



 

Note: Only path-added parts can set round angle and sharp angle. If the parts are not path-added, the 

path round angle and sharp angle will be displayed in gray. Besides, when inputting the angular 

distance, the value should be greater than the radius of the cutting torch. 

 

IX. Tools 

StarCAD also provides the users with the following tools to meet the requirements of drawing operation 

(see below): 

 

1. Chang Units 

Function: Change the measurement units of the drawing system, mainly used for the conversion 

between metric and inch units. 

Operation: Click the [Tools] -> [metric-inch conversion] menu or the  button on the 

toolbar, and the system will convert between the metric and inch units. 

Note: When saving the file, the system will automatically convert the imperial units to metric units and 

save them. 

2. Object parameter 

Function: This function can show the parameters information of the entity selected by the user, such 

as the coordinates, length, and so on. 

Operation: When there are entity graphics in the drawing area, select the [Tools] menu-> [Select 

entity parameters] to pop up the "entity information" dialog box, as is shown below. 



 

Use the mouse to select an entity object. The entity graph is displayed in red, and the information of 

the currently selected entity will be displayed in the "entity information" dialog box. Repeat this 

operation to continuously display parameters of several entities and right-click to end this operation. 

3. All entity parameters 

Function: Display all entity parameters in the current graph. 

Operation: When there are entity graphics in the drawing area, select the [Tools] menu-> [All entity 

parameters] to pop up the "all entities display" dialog box. All the parameters of the current entities 

will be shown in the dialog box, and the user can select the entity number with  and  buttons, 

while the correspondent entities will be shown in red in the graphic area and the parameter information 

of the entities will be shown in the text box of the dialog box. As shown below. 

 

4. Show parts 

Function: Display the information of the parts selected by the user. 

Operation: When there are entity graphics in the drawing area, select the [Tools] menu -> [Show 

parts ], and the system will pop up the parts number dialog box below. Double-click the name of the 

parts listed in the dialog box, and the selected parts will be shown in red.  



 

Note: The parts are numbered by the number of the closed contours (including the entities in the 

contours). 

5. Distance 

Function: This function is used to measure the distance between the two control points of the entity. 

Operation: When there are entity graphics in the drawing area, select the [Tools] menu -> [Measure 

the distance] or the  tool on the main toolbar and the system will pop up the dialog box below. 

 

Follow the on-screen prompts to select the starting point (the first point) and the ending point (the 

second point), the system will show the distance and the angle between the two points in the above 

dialog box. Repeat the operation to do more measurements. Right-click the mouse can end this 

operation. 

6. Measure the contour 

Function: Inspect the length and area of the contour. Report whether the contour is closed and other 

information related to the contour.  

Operation: When there are entity graphics in the drawing area, select the [Tools] menu -> [Measure 

the contour] and the "contour" dialog box will pop up. Left-click to select a contour entity and the 

information of the contour will show up in the "contour" dialog box, as is shown below. Chick the 

mouse, and end this operation. 



 

7. Layer settings 

Function: Set the display colors of the processing layers in order to prompt the user.  

Operation: Select the [Tools] menu -> [layer settings], or click the  tool button on the main 

toolbar. The system will pop up the layer settings dialog box (below), and the user can set the colors of 

the layers. 

 

Note: Please do not set the layer color to be the same as the background color. 

 

X. STARCAD drawing instances 

The purpose of this chapter is to quickly grasp the STARCAD drawing functions through the drawing 

instances of the following graphics. 

1.Drawing exercises 1 

Take a simple part drawing as an example (below) to illustrate the use of the StarCAD drawing functions. 



 

 Draw the reference lines 

Select the [Line] tool -] [angle line] function and the parameters of "tectonic line", "angle with the X-axis" 

with the angle value of "0". Input the coordinates of (0, 0) with the keyboard to complete the drawing of a 

horizontal line. Input the angle value of "90" degrees and the coordinates of (0, 0) to complete the drawing 

of a vertical line. Right-click to end the operation, as is shown below. 

 

 Determine the circle center point 

Select the [parallel lines] tool, input "21" as the parallel distance, and select vertical line and the right side 

as the parallel direction to finish the drawing of the parallel lines in the right. Finish the drawing of the 

parallel lines in the left by using the same method. Change the parallel distance to "11", and select 

horizontal line and the upper side as the parallel direction to finish the drawing of the horizontal parallel 

lines. As shown below. 



 

 Draw a ring 

Select the [circle] tool -] [ring] function, respectively input 12 and 18 in the inner diameter and outer 

diameter inputting box, capture "intersection A" , " intersection B" and "intersection C" on the screen to 

finish the drawing of the three rings. As shown below. 

 

 Draw the transition arc 

Use the [arc transition] function tool, input 24 in the fillet radius inputting box, and click respectively the 

upper right position of the outer circle of the left ring and the upper right position of the outer circle of the 

upper ring to draw an arc that is tangent simultaneously to the left ring and upper ring. And then click 

respectively the upper right position of the outer circle of the upper ring and the upper right position of the 

outer circle of the right ring to draw a transition arc of the upper ring and right ring. As shown below. 

 

Figure 1-6   



And then change the fillet radius to 16. Click the lower right position of the outer circle of the left ring and 

the lower left position of the outer circle of the right ring to get an arc that is tangent simultaneously to the 

left ring and right ring. As shown below. 

 

Figure 1-7   

 Delete the auxiliary lines 

Select the [delete] tool, and then click line A, line B, line C, X-axis, and Y-axis. The lines being clicked 

will be in the chosen state of red. Right-click to pop up the "Confirm Deleting dialog box", click "yes", and 

the five lines selected will be deleted. As shown below. 

 

 Trim the graph 

Select the [intelligent trimming] item under the [Modify] menu or click the  button on the toolbar. 

Click the extra lines to trim the intersecting arcs of the tangents leaving only the contour. The final drawing 

of the parts is completed. As shown below. 

 

Click the [save] tool or the [save] item under the [file] menu, input the parts data in the popping-up "input 

parts data" dialog box, and then click "OK" to save as a graphic file. 



The user can also select [drawing] -》[extract parts] menu under the [library operation], click the contour of 

the parts when prompted to select parts to pop up the library operation dialog box, and then select a library 

file to a save to a library file of the users. 

2. Drawing exercises 2 

Draw the following parts graph. 

 

 Draw the centerline and the positioning lines 

Select the [Line] tool -》[angle line] function and the parameters of "tectonic line", "angle with the X-axis" 

with the angle value of "0". Input the coordinates of (0, 0) with the keyboard to complete the drawing of a 

horizontal line. Input the angle value of "90" degrees and the coordinates of (0, 0) to complete the drawing 

of a vertical line. Right-click to end the operation, as is shown in the graph below. 

 

Select [Drawing] –》[circle] menu or click the  button on the toolbar, input 15 in the radius inputting 

box popped up, and capture the intersection point of the two straight lines with the mouse or input the 

coordinate point (0, 0) to get a circle with the radius of 15 and point (0, 0) as the circle center. As shown 

below. 



 

Change the radius values to 35 and 43 respectively, and draw two circles with the coordinate point (0, 0) as 

the center and the radius of 35 and 43. As shown below. 

 

 Draw circular arranged rings 

Using the aforementioned ring drawing method to draw a ring in the 270-degree position with the inner 

diameter of 12 and the outer diameter of 30, as is shown below. 

 

Select the [Array] tool or the [Modify] -》[Array] menu, select the just drawn ring when prompted to choose 

the array object, right-click to end the selection, and follow the prompts to give the reference point (the 

circle center of the ring). Select the [circular array] under the quick menu, input "5" for the array number, 

"72" degrees for the angle, capture the coordinates point of (0, 0) with the mouse as the center of the 

circular array. The circular array result is as shown below. 



 

 Draw keyways 

Select the [parallel lines] tool, input the parallel distance of "20", draw the up and down parallel lines with 

the X-axis, and then modify the parallel distance to "3" to draw the left and right parallel lines with the 

Y-axis. As shown below. 

 

 Delete the center lines and auxiliary lines, trim extra lines 

Click "arbitrary" under the "delete" menu, and then click the X-axis, Y-axis and circle B. The lines being 

clicked will be in the chosen state of red. Right-click to pop up the "Confirm Deleting dialog box" and click 

"yes", as is shown below. 

 

Select [Modify] -》[intelligent trimming] or click the  button on the toolbar. Click the extra lines to 

be trimmed leaving only the contour without crossover cable to get the graph, as is shown below, and the 

drawing is completed. 



 

3. Drawing exercises 3 

Draw the following parts graph. 

 

 Draw the centerline and the positioning lines 

Select the [Line] tool - 》[angle line] function and the parameters of "tectonic line", "angle with the X-axis" 

with the angle value of "0". Input the coordinates of (0, 0) with the keyboard to complete the drawing of a 

horizontal line. Input the angle value of "90" degrees and the coordinates of (0, 0) to complete the drawing 

of a vertical line. Change the angle value to "30" degrees and the drawing point to be point (0, 0) to get a 

straight line through the circle center with a counter-clockwise angle of 30 degrees. As shown below. 

 



And then get the lines of 135,330 degrees counter clockwise, which are called line B and line C 

respectively, as is shown below. 

 

 

 Draw circles with the radius of R19, R34 and R43. 

Select [Modify] –》[circle] menu or click the  button on the toolbar, input 19 in the radius inputting 

box, and give the circle center coordinates of point (0, 0). Click OK to get a circle with the radius of 19 and 

point (0, 0) as the circle center (called circle R19). As shown below. 

 

Use the circle drawing tool and draw circles with the origin point of the coordinates as the circle center and 

the radius of 34 and 43, which are called circle R34 and circle R43, as is shown below. 

 

 Draw circles with the radius of R3, R7, R4, R8, R10, R4.5 and Φ15 

The upper right intersection point of Line A and circle R34 is the center point of concentric circles R3 and 

R7. Draw circles with the radius of 3 and 7 respectively according to the circle drawing steps, which are 

called circle 3 and circle 7. As shown below. 



 

And then draw two rings with the inner diameter of 8 and the outer diameter of 20, as is shown below. 

 

And then draw a circle with the radius of 4, which is called circle R4, as is shown below. 

 

And then draw a ring with the inner diameter of 8 and the outer diameter of 16, which is called ring 3, as is 

shown below. 

 

Use the [Parallel lines] tool to draw parallel lines with the Y-axis that is "40"on the left, and draw parallel 

lines with the X-axis with the parallel distance of 6 below the X-axis. Draw a circle at the intersection point 

of the two straight lines with the diameter of 15. As shown below. 



 

Use the [Parallel lines] tool to draw parallel lines with the Y-axis that is "14"on the left, and then draw a 

circle at the intersection point of the straight line and the X-axis with the radius of 4.5, as is shown below. 

 

 Draw the edge contour and transitional arc 

And then draw several parallel lines with the X-axis. Draw parallel line X1 that is 8mm above the X-axis, 

and draw parallel line X2 and X3 that are 20mm and 10mm below the X-axis. As shown below. 

 

And then draw parallel lines with the Y-axis. Draw parallel line Y1 and parallel line Y2 respectively which 

are 47.5 and 56.5 left of the Y-axis, as is shown below. 



 

Draw two tangent circles upper and under the inner circle of the same two rings (with the radius of 38 and 

30) to form the outer and inner contours of the arc trough, as is shown below. 

 

With the [intelligent trimming] operations, trim the outer and inner contours of the arc trough and the 

trimmed graph. As shown below. 

 

Use the [two point lines] under the [straight line] tool to draw a straight line at the point P and the point Q, 

as is shown below. 



 

And then draw the upper and lower parallel lines of the straight line C (with the distance of 8), tangent to 

the outer circle of ring 3. Draw a circle with the origin point of the coordinates as the circle center and the 

radius of 29. As shown below. 

 

Trim and delete the extra segments of the above graph. The trimming and deleting results are shown below. 

 

Trim the two angle straight lines above, leaving only a short segment between circle R29 and ring 3, as is 

shown below. 



 

 Draw the transition arc of the outer contour 

Use [arc transition] tool or menu, and draw transition arc1 of the ring and the circle with the radius of 12, as 

well as transition arc2 of straight lines X1 and Y1 with the radius of 12, as is shown below. 

 

Draw the transition arcs of ring 2 and line X1, circle R7 and circle R29, two parallel lines of line C and 

circle R29 in turn, as is shown below. 

 

Draw the tangent of the inner circle of ring 3 and circle R4. Click [straight lines] -》[two circle tangent], 

click respectively the inner circle of ring 3 and circle R4 to get the tangent of the two circles, as is shown 

below. Make sure to click arc of the same direction. 



 

Use the [Intelligent trimming] tool to trim the excess lines of the above graph, as is shown below. 

 

 Improve the inner contour 

Use of [circle] tool and draw concentric circles with the center of R4.5 as its center and the radius of 11, as 

is shown below. 

 

Use the [arc transition] tool, and draw the transition arc of circle R11 and circle R19 according to the size 

requirements of the original graph, as is shown below. 

 

Trim the above graph and get the final parts graph, as is shown below: 



 

4. Drawing exercises 4 

Draw the following parts graph. 

 

 Draw the centerline and the positioning lines 

Select the [Line] tool -》[angle line] function and the parameters of "tectonic line", "angle with the X-axis" 

with the angle value of "0". Input the coordinates of (0, 0) with the keyboard to complete the drawing of a 

horizontal line; Input the angle value of "90" degrees and the coordinates of (0, 0) to complete the drawing 

of a vertical line. Change the angle value to be "30" degrees and the drawing point to be point (0, 0) to get a 

straight line through the circle center with a counter-clockwise angle of 30 degrees. As shown below. 

 



 Draw circles ofΦ28, Φ53 and R32 

Use the [circle] tool, draw a circle with the "0, 0" point as its center, the diameters of Φ28, Φ53, and the 

radius of R32, as is shown in the graph below. 

 

 Draw the outer contour 

Select the [circle] tool and draw a circle with the intersection point of the big circle and the 30-degree 

straight line as the center, and with the radius of 9, as is shown in the graph below. 

 

In accordance with the above circle drawing steps, draw a circle with the right intersection point of X-axis 

and circle R14 as the center, and with the radius of 3, as is shown in the graph below. 

 

Select the [parallel line] tool and draw parallel lines which are “3” away from the X-axis, as is shown in the 

graph below. 



 

 Trim the graph 

Use the [delete] and [intelligent trimming] tool to delete and trim the graph, leaving only part of the 

graphics, as is shown in the graph below. 

 

Use the [mirror] tool to mirror part of the contour and line A. Select the [mirror] tool and follow the 

prompts to select the set of entities to be mirrored as shown by the lines in the blue part of the graph below. 

Right-click, select a mirror line as the system prompts, and select line A with the mouse. The mirrored 

graph is as shown in the graph below. 

 

Use the [circular array] under the [Array] tool to do the circular array processing of the graph. Select the 

[Array] tool and follow the prompts to select the set of entities to be arrayed as shown by the lines in the 

blue part of the graph below. 



 

Right-click the mouse to end the selection, select [circular array] under the quick menu, input "6" for the 

array number, "60" degrees for the angle, and follow the prompts to give the center coordinates of "0, 0", or 

capture the center coordinates with the mouse. The array result is as shown below 

 

Use the [Delete] tool to delete the unwanted guides, and the final completed graph is as follows: 

 

Note: For more practical drawing instances, please see the DEMO video teaching demonstration 

after installing the software.  



 

STARCUT Nesting 

User interface: 

Double click shortcut icon StarCUT on desktop to start up StarCUT, or select the menu 

StarCUT in the start menu to start up StarCUT. The user interface of StarCUT is as shown in 

Figure 1.  

 title bar 

 pull-down menu 

 tool bar 

 drawing window 

 prompt bar 

 

Figure 1 

Title bar 

Pull-down menu 

Tool bar 

Drawing window 

prompt bar 



I. StarCUT Menu 

1. File Menu 

 

Figure 1 

1-1 New 

Function: 

This function is used to clear nesting contents in present plate, open a null file, and clear nest list, 

so as to nesting on a new plate. If the nesting contents, which are to be cleared at present, have 

not been saved beforehand, all nesting contents will be lost. 

Operations: 

Click menu 【File 】-【New】, or  in the tool bar, a new nesting file will be established. 

1-2 Open Nest 

Function: 

This function is used to open a saved nesting file beforehand, the extension name of which is 

“.NST”. After the nesting file is read in, the contents of nesting graph will be correctly displayed on 

the plate, and all parts data in nesting file will be displayed in the “nest list”. 

Operations: 

Click menu 【File】-【open Nest】, or in the tool bar. Select the nesting file to be opened in 

the dialog box of opening file, and select “open”. 

1-3 Save Nest 

Function: 

This function is used to save nesting file (.NST) and nest list file (.LST). 

Operations: 

Click menu 【File】-【Save Nest】, or  in the tool bar. After inputting name of nesting file in 

the window of file saving, click “save”. 

1-4 Nest data 

Function: 



All parameters in Nest data window are to record nesting information. And all of these parameters, 

except plate density, are manually input, and can be modified at any time. While saving nesting file, 

all parameters in “Nest data” can be saved as well. 

Operations: 

Click 【File】-【Nest data】to open Figure 1-4 for users to modify or fill in nest data. 

 

Figure 1-4 

1-5 Print 

Function: 

This function is to print details of Nest list in form of table. The information about the printed list 

includes Nest data, plate size, amount of cutting torch, file name, part’s demanded quantity, 

nesting quantity, part size, and so on, as shown in Figure 1-5: 

 

Figure 1-5 

Operation: 

Click menu 【File】-【Print】 



1-6 Print screen 

Function: 

The Plot screen function is used to send the present graph in screen to the selected printer or 

plotting instrument. When using this function, the system will pop up a dialog box of print preview, 

in which users can not only select printer and printed graph but also save or open the 

corresponding report operations. 

Operations: 

After clicking the menu 【File】- 【Print screen】 or  in the tool bar, a dialog box of file print 

preview pop ups, as shown in Figure 1-6-1: 

 

Figure 1-6-1 

After setting up the corresponding information, click the button “Print”, then the Plot screen 

operation will be realized. 

1-7 Explorer 

Function: 

The File Explorer function is used to open Windows Explorer. Here a shortcut for opening the 

Windows Explorer is provided. 

Operations: 

After clicking the menu 【File】- 【Explorer】, the system will open a Windows resource manager. 

1-8 Exit 

Function: 

This function is used to exit StarCUT program. 

Operation: 

Click menu【File】-【Exit】, or click  at the top right corner of the program window. 

 



2. View Menu 

The functional options in View menu are mainly used to control window’s display status. The menu 

structure is as shown in Figure 2: 

 

Figure 2 

2-1 Show Distance 

Function: 

This function is used to measure distance between parts or part and plate. 

Operation: 

Click menu 【Interactive】-【Show Distance】, or click  in the tool bar, then Figure 2-1-1 will 

be popped up: 

 

Figure 2-1-1 

At this time, click a point of a part’s entity edge, thus a measuring line will appear. Then click 

another edge of the part, thus in the distance display window , coordinates information about both 

the first point and the second point, as well as straight-line distance between these two points, the 

distance along X direction and Y direction respectively, and the angle of connecting line of these 

two points will be displayed. 

2-2 Indicate Window 

Function: 



Selected area can be in zoom-in View through selecting an area by using mouse to draw a box. 

Operation: 

Click menu 【View】-【Indicate window】, then select an area through using mouse to draw a box. 

The graph in this area will be displayed in full screen. The corresponding tool is . 

 

2-3 Center Indicate center 

Function:  

select center of image View through using mouse, and set up View proportion. 

Operations: 

click menu 【View】-【Center】-【Indicate center】, and select a coordinate as center of displayed 

image by using mouse. After selecting, a dialog box will be popped up for users to set up View 

proportion, as shown in Figure 2-3-1: 

 

Figure 2-3-1 

2-4 Center-Enter center 

Function:  

image is displayed with center of specified absolute coordinates, and set up View proportion. 

Operations:  

Click menu 【View】-【Center】-【Enter center】, a dialog box as shown in following figure will be 

popped up for users to input absolute coordinates which is taken as center coordinates of image 

View. After click button “Enter”, a dialog box will be popped up for users to set up View proportion, 

as shown in Figure 2-4-1: 

 

Figure 2-4-1 

After inputting center coordinates and scaling, click button “Enter”. Figure 2-4-2 is for 

reference. 



 

Figure 2-4-2 

2-5 Zoom in 

Function:  

Proportionally zoom in displayed graph. 

Operations:  

Click menu 【View】-【Zoom in】, then a dialog box will be popped up for users to input specified 

amplification coefficient, according to which the graph will then be zoomed in, as shown in Figure 

2-5-1: 

 

Figure 2-5-1 

Input the proportion of zoom in, the default is two times of zooming in. 

2-6 Zoom out 

Function:  

proportionally zoom out the displayed graph. 

Operations:  

After clicking the menu 2-1 【View】-【Zoom out】, a dialog box as shown in Figure 2-6-1 will be 

popped up for users to input coefficient of zooming out, according to which the graph will be 

zoomed out. 

 

Figure 2-6-1 

The default is two times of zoom out. 

2-7 Auto-scale 

Function:  

automatically adjust proportion to make graph be completely displayed in the present window. 



Operation:  

click menu 【View】-【Auto-scale】. 

2-8 Repeat 

Function:  

Refresh screen to make graph totally show users’ design result, and clear line section which does 

not exit. 

Operation: 

 Click menu【View】-【Repeat】. 

2-9 Previous view 

Function: 

Display graph according to the latest display setup by users. 

Operation:  

click menu 【View】-【Previous view】. 

2-10  Scale 

Function: 

make users manually set up View proportion. 

Operation:  

click menu 【View】-【Scale 】, and input proportion factor in Figure 2-10-1, then click “Enter”. 

 

Figure 2-10-1 

2-11  Plate size 

Function: 

display nesting graph in full screen with the whole plate size. 

Operation:  

click menu 【View】-【Plate size】. 

2-12  Change display 

Function:  

make users customize drawing parameters. 

Operation: 

click menu 【View】-【Change display】. This function is same as the View setup in StarCAD. 



3. Nest Setup Menu 

 

 

3-1 AutoPath Setting 

Function: The system provides the automatic processing path setting function, and the user can set the 

processing parameters and path parameters of their own to meet the processing needs. 

Operation: Select the [Path parameters settings] menu under the [processing] menu,The system 

automatically pops up the automatic path parameter settings dialog box (see below), where five pages 

are for the user to select the settings, and some of the parameters are needed for the StarCUT nesting 

modules. 

 

1) Processing type selection page (see above) 

The processing methods are provided in the “Optional processing methods” in the left, such as MARKER 

(dusting / tag), CUT (Flame / ion cut), drilling (CNC drilling), and so on. After selecting the needed 

processing method, click ">>" arrow buttons and the method can be selected to the ‘selected processing 

methods’ in the right. 

Optional processing methods 



Here listed all the cutting processions defined by the StarCAM. The processing methods here are 

to be selected, and those not being selected are also stay here. Select the processing methods in 

this table, click the ">>" arrow buttons, and then the selected processing methods will be added to 

the Selected processing methods table. Select the "Selected processing methods", click the " << 

"arrow button to delete the currently selected cutting process, and put them back into the optional 

table. 

Selected processing methods 

After selecting the cutting methods in the "Optional processing methods", the user can press the 

arrow button in the right to add them to the "Selected processing methods" in the right. If several 

processing methods are needed, the user needs to set different layers to the entities to correspond. 

For example, if a part needs flame cutting and noted line, the corresponding layers of the part 

needs to be set first. And the MARKER (dusting / tag) and CUT (flame cutting) should be 

selected here. When this processing method is not needed, select this processing method and click 

the "<<" arrow buttons, and the processing method is put back into the optional table. 

Torch compensation direction 

Click here to change the direction of the torch compensation. Left compensation, no compensation 

and right compensation can be selected. 

Processing contour range 

Click here to select the inner contour, the outer contour or all the contours of the processing parts. 

For a common cutting, all the contours should be selected here, i.e. the inner and the outer contour 

should all be processed. 

Procession for 

All parts—This option will process all the parts in order in accordance with the cutting process. 

For example, note all the parts of the plate and then cut the whole plate, which is the most typical 

processing way of the cutting machine. In this way, the air-way move distance can be the 

minimum to make the time of converting the processing methods to be the shortest when noting 

and cutting the parts. 

One part after another—This option will note and cut a part. After a part is processed, the 

subsequent parts will be processed in order. 

Pre-perforate 

This function is that first perforating the whole plate before cutting. The user can pre-perforate 

using the scrap cutting head, and cut officially with a good cutting head after the perforation. 

2) The introduction / Lead settings (below) 



 

 The introduction line: Generally, perforations are needed in the cutting process. However the 

hole is usually larger than the cutting gap. If perforating on the contours of the work piece directly, 

the contour of the work piece will be destroyed, which is not expected in the processing. As a 

result, the perforation must be on the scrap, deviating from the contour of the work piece, and 

connected to the contour processing path through a line, which is called the introduction line. 

 The Lead: After the cutting is completed, in order to make the work piece to be cut completely 

and closed to ensure the integrity and smoothness of the work piece, a line is cut out of the work 

piece contour, which is called the lead. 

 Position: Position refers to the location of the introduction and lead lines on the parts. If the 

"corner perforation" is selected, the introduction line will be added to the nearest corner point of 

the set "location". If the "corner perforation" is not selected, the introduction line will be added to 

the midpoint of the nearest entities in the set "location". Depending on the type of introduction 

line, the starting point will be as close as possible to the required position. The optional positions 

are: upper left, lower left, upper right, lower right, top, right, bottom and left. 

 Corner perforation: If the corner perforation selection box is selected, the outer boundary 

introduction line will enter from the corner point of the entity. If not selected, the introduction line 

will enter from the midpoint of the entity which is nearest to the starting position of the selected 

position box. 

 Type: Types of the introduction lines can be straight line, quarter arc, semicircle, or null. 

 Angle: When the straight line type is selected, the angle function here is activated to set the angle 

of the introduced straight line which can be 0 degree, 45 degrees and 90 degrees. The angle of the 

introduced straight line is calculated on the basis of the cutting direction. If not reasonable, the 

introduction direction given by the arc or the straight lines can also be adjusted according to actual 



situations. 

 The internal and outer boundaries are the same: All the settings of the internal path and the 

outer boundary path are the same. All settings except the "position" are not optional. 

 Drill in the corner point: After the setting, all the introduction lines will start from the corner 

point which is nearest to the introduction line of the inner boundary. If the set corner does not 

exist, then the nearest point is automatically determined. 

 Break in the longest entities: When this option is selected, the longest entity should be found in 

the inner boundary, and break from the middle of this entity adding the introduction and lead 

lines. 

 Center perforation: When the radius of the small hole is greater than or equal to the length 

of the introduction and lead lines, the introduction and lead lines will perforate through the 

middle of the holes in order to ensure that the holes are properly cut. For example, if the length of 

the introduction line is set to be 10mm, while the radius of the small hole is 4mm, the introduction 

line will automatically perforate through the middle of the holes and the length of the introduction 

and lead lines will change to 4mm. 

3) Contour compensation/ Gap settings (below) 

 

 Contour NC compensation of the parts: When this function is selected and the compensation 

value is input, you can see the added parts are automatically added by the graphics of the contour 

compensation value. There will be no codes like G41 or G42 in the output codes, applying to the 

programming of those control machines which do not support automatic compensation codes. 

Note: The codes of the StarCUT common edge nesting will be automatically output in the 

compensation way, and the compensation amount is half of the slotted width. 

 Pad sewn cutting settings: In certain circumstances, when cutting a relatively long rectangle 



completely for one time, this will lead to a very serious deformation or even a trapezoid. As a 

result, this function will reduce the occurrence of this situation. The detailed performance is to 

leave one or more places uncut in one section of the cutting path. In this way, parts can be fixed 

where they are not cut to make the cutting work piece to be correct in size and to reduce 

deformation. 

 Gap settings: This function is similar to the pad sewn cutting, and the difference is that this 

function can add the introduction line, and the gap position is not determined by the number given 

by the contour. 

4) Nesting options (below) 

 

 Nesting settings 

Nesting starting position: Set up the arrangement starting position of the parts on the plate. For a 

multi-plates nesting, this setting is also applicable. The location of the starting point can be the 

upper left corner, lower left corner, upper right corner and lower right corner. The default setting 

is the upper left corner. 

Cutting sequence：means the cutting order of the parts on the plate, which can be divided into 

rows, columns and nearest. 

 Avoid holes：In some cutting process, the cut-off parts may tilt or fall. When the torch is on the 

move, the torch will automatically drop or collide to the steel plate if there are no plates in the 

bore or the plate tilts. With this function enabled, the torch will not go through the cut-off parts 

during the move 

 Continuous short air-way cutting: Cutting short air-way line function is used for the continuous 



cutting when the introduction line and the lead between the parts are hard to get close. There is no 

need for re-perforation, and the parts cutting speed can be greatly improved. 

After the setting, the short air-way length can be input into the input box. Please input the required 

value. After selecting this function, the original fast-moving line will become the directly cutting 

line to achieve continuous cutting, if the distance between the introduction lines of a part and the 

next part is less than the given air-way length and not going through the boundary of other parts. 

This option will greatly accelerate the cutting speed and reduce perforation. 

 contour line gap 

If there are unclosed curves, and the gap is less than or equal to the set "contour line gap". Then 

the system will automatically regard the unclosed curves as closed curves. 

3-2 Plate Data 

Function: 

The plate data is used to change specification of nest plate. The type of plate data is divided into 

rectangle and excess plate. 

Operations: 

Click menu 【Nest setup】-【Plate Data】, or click  in the tool bar, thus a dialog box of plate 

data is popped up, as shown in Figure 3-3-1: 

 

Figure 3-3-1 

 Set to the default: can be in the right input rectangular plate length, width and thickness, after 

clicking this button is to establish a new set of sheet system will automatically according to the 

default set of material. 

 The default plank: automatic selection has set the default board for nesting. 

 Excess stock plank: after clicking this button system requirements is given the name of the 



position of the plate and sheet.The default excess stock plate extension. PLT. Excess stock 

plate profile is generally composed of irregular line.Users can be made of the "tools" menu 

under "generate excess stock sheet" items for more than a set of material under the figure 

automatically generate more than one material plate.Also can use a CAM draw a actual size 

of the remaining material board graphics, file, save as CAM extension to it with the resource 

management tools. PLT. 

 

3-3 Autonest parameter 

Function: 

Set up default parameter value for automatic nest. 

Operations: 

Click menu 【Nest setup】-【AutoNest Parameters】, then Figure 2-4-1 appears: 

  

Figure 2-4-1 

 Parts from the parts spacing: refers to a set of the minimum distance between parts, when the 

unit is mm; 

 Parts from the plate spacing: refers to the nesting parts and the minimum interval between 

plate edge, when the unit is mm; 

 Slot: refers to the cutting torch on the plate cutting slot width, can according to the experience 

is given depending on the type of plate thickness, cutting torch, its value must be positive and 

greater than zero. 

 Angle circular arc transition: in the path parameter automatically choose the compensation or 

a contour edge when nesting, system will compensate the contour graph of parts, check the, 

at less than 90 degree Angle will automatically Angle arc excessive, sheet to reduce the 

waste, if you don't check the circular arc transition processing is not. 

Note: the above spacing is set, the user should set before joining parts. 

 

3-4 Torches 

Function: 

This function is indicated for machine tool having multiple cutting torch heads to cut 



simultaneously. This function can be used to set up number of cutting torch of cutting machine. 

Operations: 

Click menu 【Nest setup】-【Torches】, or clock  in the tool bar, thus a dialog box is popped 

up, as shown in Figure 3-5-1: 

 

Figure 3-5-1 

The number of cutting torch is set up for n, thus the maximum of cutting torch spacing should be 

“plate width / n”. After change number of cutting torch, cutting torch spacing will automatically 

change. Cutting torch position lines, which are marked by blue lines, can be seen on plate.. 

Respective name is displayed in each cutting torch. After setting up cutting torch, nesting at one 

cutting torch is same as that at other cutting torches.  

3-5 Trim Setup 

Function: 

This function is used for excess plate cutting when NC code is generated. The excess plate can be 

used for nesting in later processing. 

Operation: 

Click menu 【Nest setup】-【Trim Setup】to pop up a dialog box, as shown in Figure 3-6-1: 

  

Figure 3-6-1 

The type of edge cutting is divided into two kinds including: 

 Straight: Straight line repair refers to cutting off excess plate, which is more than the 

“minimum width of excess plate”, in manner of straight line. 



 Contour: Contour line repair also requires setting up the value of the “minimum remnant 

width”, in order to determine usage amount of cut-off excess plate. Also the “Trim line 

clearance” should be set up, which is to set up distance between line of cut and part, and this 

repair line is set up according to present part’s edge. 

3-6 Check collisions 

Function: 

This function is used to check interference condition of nesting file. If there is interference, 

interfering entity will be displayed with red line. 

Operation: 

Click menu 【Nest setup】-【Check collisions】. 

 

4. Part Menu 

 

Figure 4 

4-1 Add From Lib 

Function:  

The add from lib function is used to add some often using parts, hold down the time of adding part. 

Operation:  

After clicking the menu 【Part】-【Add From Lib】, part lib manage window is opened, as shown 

in Figure 4-1-1: 



 

Figure 4-1-1 

Choose a lib file from the “select lib” pull down menu, select a needed part block, display the 

preview of needed part block in the right part preview frame, in the below of preview frame you 

may set the parameter of needed part block, it can be adjusted part’s size and angle according to 

actual conditions, click “OK” button, this selected part is added into plate. 

4-2 Part To Lib 

Function: to discharge the parts in the table to join to the parts in the library. 

Operation: first in the row material is selected in the table to incoming parts, click on the "parts" 

menu under “Part To Lib” menu, system will open below: 

 

Figure 4-2-1 

Users choose the gallery in figure block classification, click the "add graphics to the gallery" users 

in the selected parts nesting table will automatically be appended to the user according to the user 



given the name of the selected library file. 

 

4-3 Library management 

Function: Gallery maintenance and management 

Operation: Click the button “Library operation”  in the “Paint tools”, or choose submenu [Insert part] 

under [Library operation] menu under [Drawing] menu to pop up the dialog box of gallery management (as 

shown in the following figure). 

 

User can maintain and manage the gallery. 

 Delete parts in the gallery: Choose a source library in the drop-down menu of “Choose figure 

category”; choose a part by its name in the box of “Choose parts”; click button of “Delete” to pop 

up dialog box “Are you sure to delete?”; click “Yes” to delete the part from object gallery.  

 Rename user’s parts: Choose a part; click the button of “Rename” to pop up the part name input 

box; input a new name; click “Enter” to modify the name of the chosen part.  

 New PartLib: Click the button of “New gallery” to create a new gallery; input the name and 

click “Enter”. Gallery will be saved in LIB subdirectory under the installation directory, where 

user can delete gallery manually.  

 



4-4 Add Part 

Function: 

Increase the parts to add a new parts to cutting table, also added to the board.And the parts in the 

selected state. 

Operations: 

Click menu 【Part】-【Add Part】, or click on the button in the toolbar .System will pop up file 

open dialog (below), and choose to join in the file type selection box file types (support. CAM, 

CXF,. DWG and IGES format file), then choose the parts need to join, click "open" button, or 

double-click to open the parts directly, then the parts that are added to the discharge in the table. 

Note: if the parts are English unit drawing parts, please check the above open file dialog box at the 

bottom right corner "imperial" checkbox. 

 
4-5 Delete Part 

Function: 

The “delete part” is to completely clear away selected part from nest list. 

Operations: 

Click menu 【Part】-【Delete Part】,  thus when deleting, the prompt box of confirming will be 

popped up, as shown in Figure 4-3-1: 

 

Figure4-3-1 

4-6 Clear  parts 

Function: 

This function is to clear nesting content of part on plate, and decide if reusing present nest list. 

Operations: 

Click menu 【Part】-【Clear parts】, then the system will pop up the prompt information of “This will 

reuse previous part data. Are you sure?”, as shown in Figure 4-4-1. Click “Yes”, only clear nesting 

content of plate, but not clear nest list, just do zero clearing of nest number of all parts in the nest 

list; if click “No”, both nesting content of plate and nest list will be cleared. 

 

Figure 4-4-1 



4-7 Clear plate 

Function: 

This function is used to clear all parts on plate, but not to clear nest list, which is the difference 

between this function and the “new file” function. 

Operation: 

Click menu 【Part】-【Clear plate】 

5. AutoNest  Menu 

 
Figure 5 

5-1 Start 

Function:  

Start automatic nesting of part according to the data and parameters of the blowdown table, which are filled 

in by users. 

Operation:  

Click the menu 【AutoNest】-【Start】. During the system automatically placing part, if needing to suspend 

the automatic nesting, users can click “Pause”, and manually move the arranged part, then click “Continue” 

to recover the automatic nesting. 

Note: The manual version does not have this function. 

5-2 Pause 

Function:  

Suspend the present automatic nesting. 

Operation:  

By clicking the menu 【AutoNest】-【Pause】, users can manually move the arranged part, and then click 

“Continue” to recover the automatic nesting. 

Note: The manual version does not have this function. 



5-3 Continue 

Function: 

For the task of automatic nesting, which users have suspended, users can cease the suspension and continue 

the blowdown. 

Operation:  

Click the menu 【AutoNest】-【Continue】 to recover the automatic nesting. 

Note: The manual version does not have this function. 

5-4 Restart 

Function:  

After modifying the parameters of automatic nesting, nesting will be done again for the nesting result 

according to new parameters. 

Operation:  

Click the menu 【AutoNest】-【Restart 】. 

Note: The manual version does not have this function. 

5-5 Run Next 

Function: 

When the blowdown of present plate is satisfactory, save the blowdown of present plate, and start the 

blowdown of next blank stuff. 

Operation: Click the menu 【AutoNest】-【Run Next】 

Note:  

The manual version does not have this function. 

5-6 Move All Left 

Function: 

This function is used to move all parts on plate to the place near left side of plate, however part 

spacing given in nesting parameter is still remained. 

Operation: 

Click menu 【AutoNest】-【Move All Left t】 

5-7 Move All Right 

Function: 

This function is used to move all parts on plate to the place near right side of the plate, however 

part spacing given in nesting parameter is still remained. 

Operation: 

Click menu 【AutoNest】-【Move All Right】. 

5-8 Move All Down 

Function: 

This function is used to move all parts on plate to the place near underside of the plate, however 

part spacing given in nesting parameter is still remained. 

Operation: 



Click menu 【AutoNest】-【Move All Down】 

5-9 Move All Up 

Function: 

This function is used to move all parts on plate to the place near upside of the plate, however part 

spacing given in nesting parameter is still remained. 

Operation: 

Click menu 【AutoNest】-【Move All Up】. 

5-10   Jostle 

Function: 

The function of Jostle is used to move all parts on plate from their present positions to the place 

near the starting location of the plate, till even all parts can not move any more, however part 

spacing given in nesting parameter is still remained. The starting location of plate is represented 

by a very small green box, which can be set up in the panel “Cut order” of “NC path setup”. 

Operation: 

Click menu 【AutoNest】-【Jostle】. 

 

Figure 3-7-1 

5-11   Next Plate 

Function:  

Display the blowdown graph of the next serial number according to the sequential numbering. 

Operation: 

Click the menu 【AutoNest】-【Next Plate】. 

Note: The manual version does not have this function. 

5-12   Previous Plate 

Function:  

Display the blowdown graph of the previous serial number according to the sequential numbering. 

Operation:  

Click the menu 【AutoNest】-【Previous Plate】. 

Note: The manual version does not have this function. 

5-13   First Plate 

Function: 

Display the blowdown Graph of the least serial number according to the sequential numbering. 

Operation:  



Click the menu 【AutoNest】-【First Plate】 

Note: The manual version does not have this function. 

5-14   Last Plate 

Function:  

Display the blowdown graph of the largest serial number according the sequential numbering. 

Operation:  

Click the menu 【AutoNest】-【Last Plate】. 

Note: The manual version does not have this function. 

 

6.  Interactive Menu 

This menu is mainly used for manual nesting. 

 

Figure 4 

6-1 Clear Parts 

Function: this function is to put the selected parts are removed from the board, row material list 

parts of the data is not deleted, only the number of parts nesting lose one. 

Operation: click the Interactive menu under "Clear parts" menu, or click on the toolbar 

button . 

 

6-2 Restart 

Features: clear the discharge on the current plate as a result, each part is only keep one on board, 

so that hand matrix row material. 

Operation: click the menu the menu of Interactive-nesting under Restart menu. 



6-3 Move left 

Function: 

This function is indicated for move of single one part. It can make selected part move from right to 

left, until coming up against other parts or edge of plate. This operation will make part spacing, 

which is set up by nesting parameter, remain unchanged. When moved part interferes with other 

parts or plate, this part can not be operated. Only when this part is at totally free spacing, it can be 

moved to the left. 

Operation: 

Click menu 【Interactive】-【Move left】, or click  in the tool bar. 

6-4 Move right 

Function: 

This function is same as that of moving to left, only the moving direction of part is to right. 

Operation: 

Click menu 【Interactive】-【Move right】, or click  in the tool bar. 

 

6-5 Move down 

Function: 

This function is same as that of moving to left, only the moving direction of part is downward. 

Operation: 

Click menu 【Interactive】-【Move down】, or click  in the tool bar. 

6-6 Move up 

Function: 

This function is same as that of moving to left, only the moving direction of part is upward. 

Operation: 

Click menu 【Interactive】-【Move up】, or click  in the tool bar. 

6-7 Rotate 

Function: 

Selected parts can be clockwise Rotated. 

Operation: 

Click menu 【Interactive】-【Rotate】, or click  in the tool bar. Thus the presently selected part 

can be clockwise Rotated 90 degree. 

6-8 Position Data 

Function: 

This function is used to display position information about all selected parts, which include part’s 

name, coordinates, angle of rotation and image information. In the position window, displayed 



position of part can be changed by modifying coordinate value, also part’s angle of rotation can be 

modified, and image can be set up. 

Operations: 

Click menu 【Interactive】-【Position Data】, or double click part on plate, so as to open the position 

window of the selected part, as shown in Figure 6-8. Users can modify position and angle, then 

click “Enter”, thus the position of selected part will be changed. 

 

Figure 6-8 

6-9 Align 

Function: 

The function of Align is used to adjust a part’s position through moving and revolving this part. 

Users can firstly click one point on a part which needs adjusting, then click one point on another 

part or frame of plate, with which the first part needs aligning. 

Operation: 

Click menu 【Interactive】-【Align】, or click  in the tool bar. 

6-10   Adjust Gap 

Function: 

This function is used to readjust distance between two parts or between part and plate. Input 

distance value, which needs adjusting, in the distance input box, click “Enter”, click frame of one 

part, and click frame of another part, thus the straight-line distance between these two clicked 

points is the distance to be adjusted. 

Operation: 

Click menu 【Interactive】-【Adjust Gap】. 

6-11  Array 

Function: 

The Array is a kind of quick nest mode for manual nesting. Parts with same type can be arrayed 

according to row or column or in rectangular area. 

Operations: 



Click menu 【Interactive】-【Array】, or click  in the tool bar.Select a part, select this function, 

input needed quantity in the part quantity window, after confirming, the following options will be 

popped up, as shown in Figure 6-11-1: 

 

Figure 6-11-1 

 Automatic array: program calculates the maximum quantity of array according to the 

minimum part spacing as well as its position in the array. And nesting can be done with 

direction firstly upwards from the part’s position, and then to the right, as shown in Figure 

6-11-2: 

 

Figure 6-11-2 

 X Array: starting from the position of the part, program will make nesting for a row of 

demanded parts along positive direction of X axis, until coming up against other parts or 

edge of plate. During nesting, the minimum spacing of part will be remained. Figure 

6-11-3 is for reference: 

 

Figure 6-11-3 



 Y Array: starting from the position of the part, program will make nesting for a row of 

demanded parts along positive direction of Y axis, until coming up against other parts or 

edge of plate. During nesting, the minimum spacing of part will be remained. Figure 

6-11-4 is for reference: 

 

Figure 6-11-4 

 X Flipped: program will make nesting for a row of demanded parts in the mode of 180 

degree eversion every two parts and along positive direction of X axis, until coming up 

against other parts or edge of plate. During nesting, the minimum spacing of part will be 

remained. Figure 6-11-5 is for reference: 

 

Figure 6-11-5 

 Y Flipped: program will make nesting for a row of demanded parts in the mode of 

reversing the part every 180 degree along positive direction of Y axis, until coming up 

against other parts or edge of plate. During nesting, the minimum spacing of part will be 

remained.  

 Window Array: after users drag a window area, part nesting can be done in this window 

area. 

Note: in Array, there must be no interference between selected part and other parts, and there is 

no other parts stopping in matrix direction, otherwise operations will fail, when after adjusting part 

position, Array can be done again. 

6-12   X Mirror 

Function: 



Flip X function can be used to evert presently selected part along X axis direction. 

Operation: 

Click menu 【Interactive】-【X Mirror】 

6-13   Y Mirror 

Function: 

Flip Y function can be used to evert presently selected part along Y axis direction. 

Operation: 

Click menu 【Interactive】-【Y Mirror】 

6-14  Select part 

Function:  

select part according to serial number of part, which is given by users. 

Operations: 

Click menu 【Interactive】-【Select part】, thus a dialog box of serial number of part will be popped 

up, as shown in Figure 6-14-1.A positive integer can be input into the input box, which should be 

less than the quantity of all nesting parts. Thus the part with corresponding serial number will be in 

status of being selected, outside of which will have a yellow box. 

 

Figure 6-14-1 

6-15   Combination parts 

Features: multiple parts combined into a composite parts. 

Operation: click the menu 【Interactive】-【Combination parts 】 or click on the toolbar . .And 

select screen for composite parts graphics, selected parts with white display, selection is 

completed, click the right mouse button, the shortcut menu, select "use a combination of 

rectangular" or "use a combination of circular dislocation" (below), then the combination will join 

the nesting table as a separate parts.Automatic nesting combination parts will serve as an 

independent parts for nesting.See the "quick start" in the "basic operation" under the "parts 

combination operation". 

 



7.  Output Menu 

The functional options in output menu can make users output NC file for final nest result. The 

menu structure is as shown in Figure 7: 

 

Figure 7 

7-1 Sorting 

Function: 

Resequence for present nest result according to user’s setup. 

Operation: 

Click menu 【Output】-【Sorting】, then the functional menu of restarting sorting will be popped up, 

as shown in Figure 7-1-1: 

 

Figure 7-1-1 

Explanations on each function: 

 Column 

Array in sequence of column as priority: array upwards starting from lower left corner. When 

arraying up to top of plate, the second column is arrayed upwards starting from the second 

column of lower left corner, and the rest can be deduced by analogy, as shown in Figure7-1-2: 



 

Figure7-1-2 

 Column return 

Array in sequence of column as priority: array downwards starting from top left corner. When 

arraying up to bottom of plate, move one column to the right and then array upwards for the 

second column. The rest can be deduced by analogy. Figure 7-1-3 is for reference. 

 

Figure 7-1-3 



 Row 

Array in sequence of row as priority: array to the right starting from top left corner. When 

arraying up to the right end of plate, start from the second row of top left corner to array to the 

right for the second row. The rest can be deduced by analogy. Figure7-1-4 is for reference. 

 

Figure 7-1-4 

 Row return 

Array in sequence of row as priority: array to the right starting from top left corner. When 

arraying to the right end of plate, move downwards for one row and then array to the left for the 

second row. The rest can be deduced by analogy. Figure 7-1-5 is for reference. 

 

Figure7-1-5 

 Shortest distance 

Sequence is done starting from zero locus of plate, and the position sequence of the next part 

is determined successively according to the part nearest to the entry of part. 

 Shortest idle running 

For all sequence, select the path with shortest idle running as the final part sequence. 

 Specify 

Users can use mouse to customize part’s Cut order. When selecting, system will automatically 

give serial number to make users convenient to change. 

7-2  Bridging Mode 

Function: 

After setting up and entering into the bridging mode, and then checking this function, users can use the 

function of “line-drawing bridging” to bridge the parts in the blowdown diagram, connecting multiple parts 

into one part, therefore reducing the number of perforation. 

Operation: 



Click 【Output】-【Bridging Mode】. 

7-3 Line Bridging 

Function:  

After users check 【Bridging Mode】, this function can then be used for users to construct bridge by 

drawing line. 

Operation:  

Respectively draw a straight line at both the starting and end positions needing drawing a line, then the 

system automatically judges the contour line of the part, and automatically generates bridge at the position 

intersecting with this part, as shown in Figure 7-4-1. 

 
图 7-4-1 

 

7-4 Indicate Path 

Function: users on the system automatically join processing path are not satisfied, can be manually modify 

the part machining path compensation direction, wire type, the length of lead and lead Angle. 

Operation: click on the "processing" under the menu "manual specified path".Manual path parameters in 

the pop-up box (below) at any time can be the choice of processing path compensation mode, the 

introduction of lead wire type, length and Angle.Selection is completed, the plot click to modify parts 

processing path line, the system will automatically place in click add user selected into lead, not satisfied 

can continue to modify. 



 

 Compensation mode: can choose left (G41) and right (G42) tonic and no compensation (G40) way. 

 Introduction, pinout: "on/off" items can choose whether to join the introduction of lead;"Type" can 

choose lead is linear, a quarter circular arc, half arc, etc.;"Length" straight wire and the length or the 

radius of the circular arc wire;"Angle" in a straight line relative to the contour of lead Angle. 

 Round: "internal/external" for system cannot judge internal and external contours according to choose 

determine inner and outer contour;"Recent control points/advice" determine the introduction of lead in 

the most close to the control points, or the user to specify. 

Skill hint: users can automatically path before automatic nesting introducing the lead set in the setting of 

parameter Settings lead to no, upon the automatic nesting, the reuse manual specified path function in 

waste position to join the introduction of lead, to raise the utilization ratio of sheet. 

 

7-5 Move Entry Exit Line 

Function: modifying the introduction of the current nesting file components lead position, length and 

Angle.Using this function can be realized even cut, borrow cutting machining path, and can greatly reduce 

the number of perforation during cutting and cutting idle. 

Operation: click on the 【output】 menu of the menu 【Move Entry Exit Line】, can in the current 

discharging figure to modify parts of introducing pinout, drag the introduction of the end of the lead wire 

can change into the length of the outlet line and point of view, drag a first can be realized by cutting a parts 

of cutting edge. 



7-6 NC Output  

Function: NC code required by the CNC machine is generated for parts whose cutting path has been set. 

The NC code can do simulation processing and modification in the PLOT simulation module. The 

generated NC code files can be sent to the CNC machine by U disk. 

Operation: choose 【Output】->【NC output】 or click the  button. 

7-7 【Output】-【AutoPath Setting】 

Function:  

please refer to menu【File】-【AutoPath Setting】. 

8.  【Tools】Menu 

The functional options in Utilities menu mainly provide some auxiliary tools which can be used 

when using nest system. The menu structure is as shown in Figure 8: 

 

Figure 8 

8-1 【Tools】-【StarCAD】 

Function:  

start StarCAD system. 

8-2 【Tools】-【Scrap Cut】 

Function: 

Users can set up excess plate cutting line on plate. This cutting line can generate NC codes which 

are appended to the back of NC codes, generated by part cutting, when executing 【output】 

operation. The excess plate is cut after part cutting. 

Operations: 

Click menu 【Utilities】-【Scrap Cut】, then a dialog box of selecting adding or editing cutting line 

will be popped up, as shown in Figure 7-4: 

 

Figure 7-4 

 Add 

Use mouse to set up coordinates of starting point and terminal point, so as to add an 

excess plate cutting line. 

 Remove One 



Select the excess plate cutting line, which is selected by users, to delete it. 

 Remove all 

Delete all excess plate cutting lines. 

8-3 【Tools】-【Create surplus plate】 

Function: 

Generate an excess plate file for the present excess material of the plate. This file can be used for later 

excess plate. 

Operation:  

Firstly select the menu 【Nest Setup】-【Trim Setup】 to select the type of edge cutting. And set up the 

scrap cut line in the 【Tools】-【Scrap Cut】, then click the menu 【Tool】-【Create surplus plate】to give 

both the saving position and file name in the dialog box of save file, then click “Save”. The extension of the 

saved excess plate file is .PLT. 

 

9. 【Language】menu 

 

Switch between languages, so that users are convenient to set up their used classification of 

language. 



 

II. STARCUT Nest Examples 

Users should do cutting and nesting with STARCUT according to the steps mentioned in the 

following flow diagram: 

 

In the following application examples, nesting parameters are as follows: 

 Set up plate size: 3000*2200 millimeter 

 Automatic nesting parameters: spacing between parts is 10 millimeter, and spacing 

between part and plate is 15 millimeter. 

 File type setup is “cam - nc”. 



 Automatic path parameter setup: omit, and refer to concerned chapter. 

1. Regular graph nest 

（1） Add a part as shown in Figure 1-1, select the part, click button “Move down”, thus 

the part is moved to the lower left corner of plate. Then click “Array” in menu 

“Interactive”, the “input quantity” box is popped up, as shown in Figure 1-2. 

 

Figure 1-1 

 

Figure 1-2 

（2） An integer more than 2 is input as quantity; click “OK”, the menu of “select matrix 

form” is popped up, as shown in Figure 1-3. Click “Automatic Array”, then the 

“automatic array setup” window is popped up, as shown in Figure 1-4. 

 

Figure 1-3 



 

Figure 1-4 

（3） In window of “automatic array setup”, input 18 for total, and click “OK”, thus parts 

can automatically array on the whole plate, as shown in Figure 1-5. As for the 

empty part of the plate, other parts can be arrayed there. 

 

Figure 1-5 

（4） When arraying, program will give a serial number to each part according to their 

array sequence. The sequence of part’s serial number is part’s Cut order. Users 

can restart sorting according to the “Resequence” function in “output” menu. 

（5） After doing part nest, use “output” function in “output” menu to output NC file, and 

NC file code generated in StarTEST can be emulated and checked. The NC 



codes after emulation and checking can be directly output to cutting machine tool 

for cutting control. 

（6） Use the “Save Nest” function in “Nest setup” menu to save arrayed nesting file 

which can then be read in to be modified by using the “Retrieve Nest” function, 

and data in nesting list can be repetitively used. 

2. Irregular graph nest 

（1） Add a part as shown in Figure 2-1, select the part, click button “move down”, thus 

the part is moved to the lower left corner. Then click “Array” in menu “Interactive”, 

the “input quantity” box is popped up. 

 

Figure 2-1 

（2） An integer more than 40 is input as quantity, click “OK”, then click “Y Array” in the 

popped-up menu of “select matrix form”, thus the nest result can be got as shown 

in Figure 2-2. 

 

Figure 2-2 

（3） Select the part with serial number 1, then use the array mode of “X Flipped” in 

“Array”, thus the nest result can be got as shown in Figure 2-3. 



 

Figure 2-3 

（4） Successively select parts along Y axis direction, and the array mode is “X 

Flipped” , thus the final array result can be got as shown in Figure 2-4. 

 

Figure 2-4 

（5） Click “Jostle” in menu “AutoNest”, thus nest result can be got as shown in Figure 2-5. 

 

Figure 2-5 

（6） Entry or serial number of part can be modified. Then output NC file, and the NC file 



codes generated in StarTEST can be emulated and checked. The NC codes after 

emulating and checking can be directly output to cutting machine tool for cutting 

control. 

3. Circle’s triangle nest example: 

（1） Add a part as shown in Figure 3-1, click button “Move down” to move the part to 

the lower left corner. Then select part, click “Array” in menu “Interactive”, thus the 

“input quantity” box is popped up. 

 

Figure 3-1 

（2） An integer more than 1 is input; click “OK”, thus the menu “select matrix form” is 

popped up. Then click “Automatic Array”, the window “automatic array setup” is 

popped up. And input 88 as the total, select “Triangle” in “Move Up”, then click 

“OK”, the array result is got as shown in Figure 3-2. 

 

 

Figure 3-2 

（3） Parts are arrayed on the whole plate. Note: the “Triangle” Array is only effective 

on circular and rhombic parts. 

4. Example of how to reduce idle running when nesting 

In the following Figure 4-1 which is the graph of finished nesting, dash not line is the idle running 

line. Because idle running is greatly dispersed, idle running in cutting takes long time. 



 

Figure 4-1 

If collecting positions of Entries and Exits on one place, as shown in Figure 4-2, through 

corresponding revolving or image processing of arrayed parts, length of idle running line 

can be greatly reduced, and cutting efficiency can be improved. 

 

 

Figure 4-2 



STARTEST NC Code Emulation 

 
Emulation module can do graph emulation in computer for NC codes generated by STARCAM or 
STARCUT, and do single step run and step-by-step emulation, also edit and modify NC codes in 
the process of emulation, test and verify the correctness and rationality of NC codes, so as to 
improve production efficiency. 
Operations: 

Double click icon  on desktop to open program STARTEST; 
Or open program STARTEST through “Output NC code” in menu “NC path” of STARCAD;  
Or open program STARTEST through “output ” in menu “Output” of STARCUT. 
STARTEST operation interface is as follows: 

 
The followings are the function descriptions of buttons in tool bar: 

 

  is used to open NC code file. After clicking this button, system will pop up a dialog box 
“open file”, as shown in the following figure. When users select NC code file, a preview of NC code 
graph can appear in the right preview box. Click button “open NC file”, selected NC code file can 
be opened. 

  is used to edit NC code content. After clicking this button, code edit interface as shown in 
the following figure will be popped up. After users modify NC code according to their need, click 
“Enter”, thus present NC code editing is completed. After exiting editing, modified processing locus 
graph can appear in the corresponding locus emulation area. 

NC code  Cutting path 
emulation 

TOOL button



 

  is used to save modified NC code. After clicking, the dialog box of saving NC code is 
popped up. Then click button “save” to complete saving, also users can save as another name. 

 is used to direct NC code pointer to the first row of NC codes, meanwhile graph in locus 
emulation area is cleared. 

  is used to direct NC code pointer to the last row of NC codes, meanwhile the whole graph is 
displayed in locus emulation area. 

  is used to move NC code pointer backwards for one process step, meanwhile the graphs 
up to last process step are displayed in locus emulation area. 

  is used to move NC code pointer forwards for one process step, meanwhile the graphs up 
to the next process step are displayed in locus emulation area. 

  is used to do continuous process step emulation according to automatic emulation interval 
set up by users. Emulation speed can be controlled through adjusting the value of “automatic 
emulation interval”. 

  is used to pause continuous process step emulation. 

  is used to display in full screen the cutting locus in locus emulation area. 

  is used to zoom out 0.8 times of the graph in locus emulation area. 

  is used to zoom in 0.8 times of the graph in locus emulation area. 

  is used to move processing locus graph in locus emulation area through mouse. 

  is used to maximize, in locus emulation area, display of locus graph within the window 
dragged by mouse. 

  is used to open dialog box of emulation parameter setup, as shown in the following figure, 
and modify emulation parameters.  



 
Direction: decide if directive arrow of processing locus direction is displayed in emulation graph. 
Idle running: decide if idle running code, i.e. G0 code, in processing locus is displayed in emulation 
graph. 
Perforate: decide if perforating code emulation in processing locus is displayed in emulation 
graph. 
Automatic substep emulation spacing: decide interval between tools when continuously emulating. 

  is used for processing cost calculation. After clicking, a dialog box of cost calculation is 
opened, as shown in the following figure, where users can estimate processing cost through filling 
in concerned contents. 

 



Appendix I.  Explanation on Modification of Control File 
Because a part of auxiliary code formats in NC codes needed by cutting control machine are 
different for different cutting control machine, or because the start or terminate format of program 
is different, generated NC codes can be used only after manual modification. In this respect, this 
software specially provides the function of automatic code format matching, with which users can 
match codes of their used control machine according to the model number of the control machine 
through modification of part of contents in control file. 
The format content of control file (control.con) for Chinese edition is as follows: 
* CONTINUOUS OPERATIONS 
*    1. OPERATION NAME.  UP TO 15 CHARACTERS 
*    2. 0=SINGLE 1=CONTINUOUS 2=CUTTING (ENTRIES/EXITS) 
*    3. DEFAULT KERF. LEFT=-1 NONE=0 RIGHT=1 
*    4. LINE COLOR 
*    5. LINE TYPE 0/1=SOLID 2=DASHED 3=DOT-DASH 4=DOTTED 
*    6. PLOTTER NUMBER 1 THROUGH 8.  ALL 1'S MAKES FOR FASTER PLOTTING 
*    7,8,9,10 ON,OFF,START,STOP 
* FOR SOME PROCESSES SUCH AS DRILLING, THERE MAY ONLY BE AN ON PHRASE 
* FOR SOME SUCH AS PLASMA, THERE WILL BE ALL FOUR. 
* THE LAST TWO FIELDS ARE COLOUR, CHARACTER (FOR SINGLE OPERATIONS) 
* THERE IS A MAXIMUM OF 15 OPERATIONS 
* SINGLE OPERATIONS 
*     1. OPERATION NAME.  UP TO 15 CHARACTERS 
*     2. 0=SINGLE 1=CONTINUOUS 2=CUTTING (ENTRY/EXIT) 
*      3. 0=NOT USED AT PRESENT. NO KERF FOR SINGLES 
*      4. COLOUR 
*      5. SYMBOL 
/OPERATIONS/ 
* OPER   CONT  KERF  COL  LTYPE/ CHAR   PLOTTER ON,OFF,START,STOP 
CUT,       2,      -1,    10,      1,             1,       M06, M07,M11,  M12 
MARKER,   1,       0,    13,      2,             1,      M10, M09,M90,  M91 
/KERF RIGHT/ 
G42 
/KERF LEFT/ 
G41 
/KERF OFF/ 
G40 
* GENERAL UTILITY STATEMENTS 
/PRECOMMENTS/ 
/OPENING STATEMENTS/ 
/COMMENT ON/ 
/COMMENT OFF/ 
/RAPID ON/ 
/RAPID OFF/ 
/BEVEL ON/ 
/SUSPEND/ 
/CANCEL BEVEL/ 
/CLOSING STATEMENTS/ 
M02 
/START OF NEST/ 
/END OF NEST/ 
M02 
/HALT/ 
/SWITCHES/,1,0,0,0,0,0,1 
/DXF/ 
CUT,1 
MARKER,2 
/COLOURS/ 
* ID R G B 
1 0 0 255 
2 0 128 0 
3 0 0 255 
4 255 0 0 
5 255 0 255 
6 255 255 0 
7 255 255 255 
8 0 0 0 



9 0 0 255 
10 0 220 0 
11 0 0 255 
12 255 0 0 
13 255 0 255 
14 255 255 0 
15 255 255 255 
16  0 0 0 
 
Application example: in the code format of cutting machine used by some factory, the codes of 
cutting torch on and cutting torch off are respectively M06 and M07, cutting start and terminate 
codes are respectively M00 and M02, marker processing on and off codes are respectively M09 
and M10, and marker start and terminate codes are respectively M71 and M70. Before using this 
software, users need only utilize text edit tool to open file control.con in software installation 
directory, and modify contents of concerned section, thus codes suitable for cutting machine can 
be generated. For example, the content of processing code section before modification is as 
follows: 
After saving file, processing codes suitable for this factory can be generated in StarCAD and 
StarCUT. Content of control file can also be seen in menu【control point】-【NC display】of 
StarCAM. 



Sales and Technical Support 

 

Beijing Starfire Control Technology Co., Ltd. 

Address: haite Garden Room 405 No. 44 Shijingshan District Beijing City 

Sales: 010-88909875 

After-sales service: 010-88797100 

Fax： (86)010-68866955 

Postcode: 100041 

Web site： http://www.starfirecnc.com 
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